1. About this manual .................................................................5
   1.1. Copyrights ...........................................................................5
   1.2. Trademarks ...........................................................................5
   1.3. General ...............................................................................5
   1.4. Use of symbols .....................................................................6
   1.5. Document conventions .......................................................6
   1.6. Terminology .........................................................................7
   1.7. Abbreviations .......................................................................8
   1.8. Related documents ..............................................................9
   1.9. Document revisions ..............................................................9

2. Introduction ..............................................................................11
   2.1. Connecting to an application ...............................................11
       2.1.1. Login ..............................................................................11
       2.1.2. Logout ...........................................................................12
   2.2. Application views ...............................................................13
   2.3. Controlling process displays ...............................................14
       2.3.1. Controlling process displays .........................................14
       2.3.2. Adding note marker .......................................................16
   2.4. Monitor Pro layout .............................................................17
       2.4.1. Specifying toolbars .......................................................18
       2.4.2. Default menus .............................................................18
       2.4.3. Changing application layout .......................................19
       2.4.4. Reseting application layout .......................................24
   2.5. Using process lists .............................................................25
   2.6. Using reports .................................................................25

3. Monitor Pro basics .................................................................27
   3.1. Options ...............................................................................29
       3.1.1. Application settings .....................................................30
       3.1.2. Language settings .........................................................31
       3.1.3. Lockout duration ..........................................................32
       3.1.4. Daylight settings ..........................................................33
       3.1.5. Process control settings ..............................................34
       3.1.6. Show object identification ..........................................35
       3.1.7. HD space alarm ...........................................................36
       3.1.8. Report settings ..............................................................37
   3.2. User management .............................................................38
       3.2.1. Defining user interface ..................................................39
       3.2.2. Adding user .................................................................40
       3.2.3. Removing user .............................................................41
       3.2.4. Adding group ...............................................................41
       3.2.5. Removing group ..........................................................42
3.2.6. Changing password ......................................................... 43
3.2.7. Defining view monitors .................................................... 43

3.3. Calendar .............................................................................. 44
3.3.1. Opening Calendar ........................................................... 44
3.3.2. Making selections ............................................................ 46
3.3.3. Adding day type to group of days .................................... 46
3.3.4. Setting day type attributes ............................................... 46
3.3.5. Saving attributes ............................................................ 46
3.3.6. Changing current time ..................................................... 46
3.3.7. Setting day attributes ..................................................... 47
3.3.8. Setting calendar options .................................................. 49
  3.3.8.1. General calendar options ................................... 49
  3.3.8.2. Procedures ........................................................ 50
  3.3.8.3. Day types ........................................................... 51

4. Process controlling .............................................................. 53
  4.1. Station Local/Remote control ................................................ 53
  4.2. Bay Local/Remote control ..................................................... 55
  4.3. Switch control ................................................................... 58
    4.3.1. Blockings .............................................................. 59
    4.3.2. Forced operations ..................................................... 60
    4.3.3. Simulation .............................................................. 62
    4.3.4. Alarms ................................................................. 63
      4.3.4.1. Auto-reclose ....................................................... 64
  4.4. Transformer voltage control .................................................. 65
  4.5. Measurement control .......................................................... 69
  4.6. Busbar Coloring ................................................................ 76

5. Event List .............................................................................. 79
  5.1. Starting Event List ............................................................. 81
  5.2. Configuring user interface ................................................... 82
    5.2.1. Configuring layout settings ....................................... 85
    5.2.2. Changing event line layout ....................................... 85
    5.2.3. Changing event texts ............................................... 86
    5.2.4. Viewing and listing events ........................................... 86
    5.2.5. Scrolling events ......................................................... 87
    5.2.6. Sorting columns ......................................................... 87
    5.2.7. Finding events .......................................................... 87
    5.2.8. Printing ................................................................. 88
  5.3. Handling events ............................................................... 88
    5.3.1. Configuring Event List settings ................................... 89
    5.3.2. Registrating events .................................................... 90
    5.3.3. Adding comments ..................................................... 90
    5.3.4. Reading events from HDB files ................................... 91
5.3.5. Locating object ................................................................. 91
5.3.6. Copying events ................................................................. 91
  5.3.6.1. User authorization .............................................. 91
5.3.7. Updating Event List .......................................................... 91
5.4. Using filters ................................................................. 92
  5.4.1. Configuring color settings ........................................ 92

6. Alarm List ................................................................................. 95
  6.1. Starting Alarm List ............................................................ 97
  6.2. Configuring user interface ................................................ 99
    6.2.1. Configuring Alarm List layout ................................. 101
    6.2.2. Sorting columns ..................................................... 102
    6.2.3. Finding alarms ....................................................... 102
  6.3. Handling alarms .............................................................. 102
    6.3.1. Configuring Alarm List settings ............................. 104
    6.3.2. Alarm List presentation modes ................................. 105
    6.3.3. Locating objects ...................................................... 105
    6.3.4. Copying alarms ....................................................... 105
    6.3.5. Acknowledging alarms ............................................ 106
    6.3.6. Alarm text indication ............................................. 106
    6.3.7. Resetting alarms ..................................................... 107
  6.4. Using filters ................................................................. 107
    6.4.1. Defining filters ...................................................... 108
    6.4.2. Saving filter setting ............................................... 110
    6.4.3. Opening filter setting ............................................ 110
    6.4.4. Time filters .......................................................... 110
    6.4.5. Filter shortcuts ...................................................... 111

7. Blocking List .......................................................................... 113
  7.1. Starting Blocking List ........................................................ 114
  7.2. Configuring user interface ............................................... 115
    7.2.1. Configuring Blocking List settings .......................... 116
    7.2.2. Sorting columns ..................................................... 117
    7.2.3. Finding blockings ................................................... 117
    7.2.4. Printing blockings .................................................. 117
  7.3. Handling blockings .......................................................... 118
    7.3.1. Setting signal blocking state ................................... 118
    7.3.2. Blocking attributes and blocking types ..................... 119
    7.3.3. Locating object ....................................................... 120
    7.3.4. Copying blockings ................................................ 120
  7.4. Selective Signal Blocking .................................................. 120
  7.5. Blocking in displays ...................................................... 122

8. Trends ....................................................................................... 125
  8.1. Starting Trends display .................................................... 126
# MicroSCADA Pro

## Operation Manual

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.2</td>
<td>Configuring user interface</td>
<td>127</td>
</tr>
<tr>
<td>8.2.1</td>
<td>Scrolling, panning and zooming in the graph mode</td>
<td>129</td>
</tr>
<tr>
<td>8.2.2</td>
<td>Printing trends</td>
<td>129</td>
</tr>
<tr>
<td>8.2.3</td>
<td>Saving preconfiguration</td>
<td>130</td>
</tr>
<tr>
<td>8.3</td>
<td>Handling trends</td>
<td>130</td>
</tr>
<tr>
<td>8.3.1</td>
<td>Adding and deleting trend objects</td>
<td>131</td>
</tr>
<tr>
<td>8.3.2</td>
<td>Editing values</td>
<td>131</td>
</tr>
<tr>
<td>8.3.3</td>
<td>Clearing trend data</td>
<td>132</td>
</tr>
<tr>
<td>8.3.4</td>
<td>Exporting to text file</td>
<td>132</td>
</tr>
<tr>
<td>8.3.5</td>
<td>Copying trends</td>
<td>132</td>
</tr>
<tr>
<td>8.4</td>
<td>Working with Trend Basket</td>
<td>132</td>
</tr>
<tr>
<td>8.5</td>
<td>Using trend curves</td>
<td>134</td>
</tr>
<tr>
<td>9</td>
<td>System Self Supervision</td>
<td>137</td>
</tr>
<tr>
<td>9.1</td>
<td>Introduction to system supervision</td>
<td>137</td>
</tr>
<tr>
<td>9.2</td>
<td>Supervision monitoring</td>
<td>139</td>
</tr>
<tr>
<td>9.2.1</td>
<td>Status indication</td>
<td>140</td>
</tr>
<tr>
<td>9.2.2</td>
<td>Event and alarm indications</td>
<td>141</td>
</tr>
<tr>
<td>9.3</td>
<td>Supervision Log Viewer</td>
<td>142</td>
</tr>
<tr>
<td>9.3.1</td>
<td>Starting Supervision Log Viewer</td>
<td>142</td>
</tr>
<tr>
<td>9.3.2</td>
<td>Toolbar and menus</td>
<td>143</td>
</tr>
<tr>
<td>9.3.3</td>
<td>Types of log events</td>
<td>150</td>
</tr>
<tr>
<td>9.3.3.1</td>
<td>Common events</td>
<td>150</td>
</tr>
<tr>
<td>9.3.3.2</td>
<td>Undefined Process Object events</td>
<td>151</td>
</tr>
<tr>
<td>9.3.3.3</td>
<td>Operating System events</td>
<td>152</td>
</tr>
</tbody>
</table>
1. About this manual

1.1. Copyrights

The information in this document is subject to change without notice and should not be construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for any errors that may appear in this document.

In no event shall ABB Oy be liable for direct, indirect, special, incidental or consequential damages of any nature or kind arising from the use of this document, nor shall ABB Oy be liable for incidental or consequential damages arising from use of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written permission from ABB Oy, and the contents thereof must not be imparted to a third party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and may be used, copied, or disclosed only in accordance with the terms of such license.

Copyright © 2005 ABB Oy
All rights reserved.

1.2. Trademarks

ABB is a registered trademark of ABB Group.
All other brand or product names mentioned in this document may be trademarks or registered trademarks of their respective holders.

1.3. General

The Control System SYS 600 *9.1 consists of basic functions needed for application handling, for example, SA-LIB standard objects, process lists and busbar coloring. SA-LIB standard objects consist of generic standard functions that are used to monitor and control substations, as well as electrical power transmission and distribution systems.

The new user interface is implemented as a new monitor type called Monitor Pro in SYS 600 *9.1. If the new user interface is used with an existing process database, the format picture mechanism must be migrated to the new event handling concept. The classic Monitor is still available for showing specific processes. The size of the classic Monitor can be from 640 by 480 pixels per inch up to 1600 by 1200 pixels per inch. The type of the monitor can be determined to VS-Local, VS-Remote or X-Monitor. There can be up to 100 monitors open at the same time.
1.4. **Use of symbols**

This publication includes caution and information icons that point out safety related conditions or other important information to the reader. The corresponding icons should be interpreted as follows:

- The caution icon indicates important information or warning related to the concept discussed in the text. It might indicate the presence of a hazard which could result in corruption of software or damage to equipment or property.

- The information icon alerts the reader to relevant facts and conditions.

Although warning hazards are related to personal injury, and caution hazards are associated with equipment or property damage, it should be understood that operation of damaged equipment could, under certain operational conditions, result in degraded process performance leading to personal injury or death. Therefore, comply fully with all warning and caution notices.

1.5. **Document conventions**

The following conventions are used for the presentation of material:

- The words in names of screen elements (for example, the title in the title bar of a dialog, the label for a field of a dialog box) are initially capitalized.

- Capital letters are used for the name of a keyboard key if it is labeled on the keyboard. For example, press the CTRL key. Enter key is an exception, for example, press Enter.

- Lower case letters are used for the name of a keyboard key that is not labeled on the keyboard. For example, the space bar, comma key and so on.

- Press CTRL+C indicates that you must hold down the CTRL key while pressing the C key (to copy a selected object in this case).

- Press ESC E C indicates that you press and release each key in sequence (to copy a selected object in this case).

- The names of push and toggle buttons are boldfaced. For example, click **OK**.

- The names of menus and menu items are boldfaced. For example, the **File** menu.

- The following convention is used for menu operations: **Menu Name > Menu Item > Cascaded Menu Item**. For example: select **File > Open > New Project**.

- The **Start** menu name always refers to the **Start** menu on the Windows Task Bar.

- System prompts/messages and user responses/input are shown in the Courier font. For example, if you enter a value out of range, the following message is displayed:

  Entered value is not valid. The value must be 0 to 30.
You may be told to enter the string MIF349 in a field. The string is shown as follows in the procedure:

MIF349

- Variables are shown using lower case letters:
  sequence name

1.6. Terminology

<table>
<thead>
<tr>
<th>Term</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>All the processes and views included in an application. Normally an application consists of an overview or a login dialog and several process displays and application views.</td>
</tr>
<tr>
<td>Application view</td>
<td>An application view gives the user an overview of the application. A process display is a picture, which shows a specific process in a station. In a very small application they can all be the same.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Attributes contain the settings and definitions for the properties of the picture functions. They are stored in the process data base.</td>
</tr>
<tr>
<td>Authorization</td>
<td>Different users can have different access rights to the same picture functions and processes.</td>
</tr>
<tr>
<td>Authorization group</td>
<td>Picture functions and application pictures can be grouped into authorization groups and thereby requiring a certain user authorization level.</td>
</tr>
<tr>
<td>Authorization level</td>
<td>Different levels of authorization give the users different types of access (view, control operations, system manager and so on.).</td>
</tr>
<tr>
<td>LIB 500</td>
<td>LIB 500 contains the needed base functionality for installing support packages like LIB 510, LIB 5xx... LIB 500 also provides functions like Event List, Alarm List, and Busbar coloring.</td>
</tr>
<tr>
<td>LIB 510</td>
<td>LIB 510 is a support package, which contains the library functions for using for example MV process functions, Trend reports, SPACOM Relay Setting Tool, RED Relay Setting Tool, DR-Collector Tool.</td>
</tr>
<tr>
<td>Library function</td>
<td>A library function is a function in a software package that is ready made and only needs configuration of the attributes.</td>
</tr>
<tr>
<td>Menu item</td>
<td>The available options that are listed when opening a drop-down menu.</td>
</tr>
<tr>
<td>MFU</td>
<td>A multi-function unit, such as a relay or a terminal, with various functions.</td>
</tr>
<tr>
<td>MicroSCADA session</td>
<td>The whole operation from starting up the system, performing login, running the system with its customer application to ending the session.</td>
</tr>
<tr>
<td>MV process</td>
<td>Medium Voltage functions like Circuit breaker, Transformer, Three state switch, Station, Bay, and so on. used as picture functions in the process displays.</td>
</tr>
<tr>
<td>Picture function</td>
<td>The functionality is built in with the application picture presented on the monitor. However, the application picture can contain one or several different picture functions, as well as several similar ones (disconnectors, transformers, and so on.).</td>
</tr>
<tr>
<td>Picture specific area</td>
<td>An area where process specific functions are presented.</td>
</tr>
</tbody>
</table>
1.7. Abbreviations

The following is a list of abbreviations you should be familiar with. See also the terminology table above.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clut</td>
<td>Color LookUp Table, file where Display Builder saves the RGB (Red, Green, Blue) values for each color in color palette.</td>
</tr>
<tr>
<td>DMS</td>
<td>Distribution Management System</td>
</tr>
<tr>
<td>HDB</td>
<td>History Database</td>
</tr>
<tr>
<td>HSI</td>
<td>Human System Interface</td>
</tr>
<tr>
<td>IED</td>
<td>Intelligent Electronic Device</td>
</tr>
<tr>
<td>MFC</td>
<td>Microsoft Foundation Classes, set of basic components for Windows user interface.</td>
</tr>
<tr>
<td>MFU</td>
<td>Multi-function unit</td>
</tr>
<tr>
<td>MV</td>
<td>Medium Voltage</td>
</tr>
<tr>
<td>NCC</td>
<td>Network Control Center</td>
</tr>
<tr>
<td>SA</td>
<td>Substation Automation</td>
</tr>
<tr>
<td>SCS</td>
<td>Substation Control System</td>
</tr>
<tr>
<td>SSS</td>
<td>System Self Supervision</td>
</tr>
<tr>
<td>WMF</td>
<td>Windows Meta File</td>
</tr>
</tbody>
</table>
1.8. Related documents

<table>
<thead>
<tr>
<th>Name of the manual</th>
<th>Document ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMS 600 *4.1 Operation Manual</td>
<td>1MRS755274</td>
</tr>
<tr>
<td>LIB 500 *4.1 Configuration Manual</td>
<td>1MRS755360</td>
</tr>
<tr>
<td>LIB 510 *4.1 Configuration Manual</td>
<td>1MRS755364</td>
</tr>
<tr>
<td>SYS 600 *9.1 Application Design</td>
<td>1MRS755387</td>
</tr>
<tr>
<td>SYS 600 *9.1 Process Display Design</td>
<td>1MRS755379</td>
</tr>
</tbody>
</table>

1.9. Document revisions

<table>
<thead>
<tr>
<th>Version</th>
<th>Revision number</th>
<th>Date</th>
<th>History</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>9.0</td>
<td>30.06.2004</td>
<td>Document created</td>
</tr>
<tr>
<td>B</td>
<td>9.1</td>
<td>10.03.2005</td>
<td>Updates to the control dialogs and content of the manual. Several new functions added: Tap changer, Measurement control, note marker.</td>
</tr>
</tbody>
</table>
2. Introduction

This chapter gives an introduction to SYS 600 *9.1 functions. These functions are to some parts described in more detail.

The work can be separated to an engineering phase, when configuring the application by means of the system tools and a runtime phase, when the prepared and configured application is used and connected to the process.

This Operation Manual does not deal with the engineering phase. The focus is set to using the SA-LIB related functionality after a proper configuration.

You may notice that all application areas and functions provided by SA-LIB described in this operation manual are not covered by your application. This is because the functionality of individual applications is designed according to the needs of the customer. Vice versa, your application may feature functionalities, which are not described in the scope of this manual.

2.1. Connecting to an application

The system specific Login dialog is displayed when Monitor Pro is started. When Monitor Pro starts, it requires login before the session can continue.

![Monitor Pro Login dialog](login_dialog)

Clicking Close in the Login dialog closes the Login dialog, but leaves the Monitor Pro still running.

2.1.1. Login

To login select an application from the Application drop-down list. In an application built with LIB 500, the start picture requests a user name and a password. Type them to the corresponding boxes and click OK.
Each user is associated with a certain user profile defined by the system manager. For more information on defining user profiles, refer to Section 3.2. User management.

If the user name and the password do not match, or the user name does not exist, the Login dialog is displayed again and you can make a new attempt. Each attempt to login is registered by the system, even those that fail.

If the login succeeds, the first picture is produced on the screen. All the operations subsequently performed on the Monitor Pro, are related to the authority profile associated with the user name. The user name is also included in as an identifier in the event register when certain manual operations are performed.

In order to prevent anybody else from using your user name and authority profile, always logout or reset the authority level when leaving the control room.

2.1.2. Logout

In Monitor Pro, logout means that your name and user authority are cleared.

The logout is done when:

- You select Main > Logout.
- You close the Monitor Pro by selecting Main > Exit.
- Automatic time based logout is done by Monitor Pro
- The MicroSCADA application state is changed from HOT to WARM or COLD
- The MicroSCADA OPC DA server or MicroSCADA service is stopped

Time based logout

After a certain time, for example 8 hours, an automatic logout is done. The logout duration is defined in the application settings, that is, the setting is user specific. You have to login again via the Login dialog.
2.2. Application views

Fig. 2.2.-1 is composed of some examples of application views. It shows an Alarm List and a Trend Report.

Application views display the supervised processes. There are many different types of application views: single line diagrams, process displays, system supervision, lists, application tools, measurement reports and trend reports.

Fig. 2.2.-1 Examples of application views

It is recommended to have only one application view displayed within the same monitor. Opening an another function closes or hides the previous one. However, application views can be shown in different places and in the several monitors at the same time. If two or more monitors display the same application processes, viewing and/or using the LIB 500 and LIB 510 functions are ruled by the user’s authorization level.

Your application may contain one or more applications or process displays, which can be accessed from the main menubar.
2.3. **Controlling process displays**

A process display is a view, which is displayed when the user is logged into an application. The process displays contain information on the process of the MicroSCADA system in the form of graphical appearance of objects with dynamic behaviour, see Fig. 2.3.-1. Process displays in the MicroSCADA Pro Monitor contain functions for zooming, panning and de-cluttering of displays.

On the title bar of the process display view is presented the name of the display, the application’s name and number as well as the login user.

Fig. 2.3.-1  *Main view of a control dialog*

More information on how to create process displays with the SYS 600 Display Builder is described in the SYS 600 *9.1 Process Display Design manual.

2.3.1. **Controlling process displays**

Fig. 2.3.-1 shows an example of a station process display in form of a single line diagram. The MV processes can generally be shown in the process display by different presentations; the presentation to be used is selected when the process displays are configured. Different colors are normally used for indicating the status, but also to indicate whether an object is connected to the process or not, and so on.
You can interact with the MicroSCADA system’s processes through the control dialogs accessed from the process display, see Fig. 2.3.-1. Only the users, who belong to certain user groups are allowed to execute control operations to the process devices of the MicroSCADA system.

![Switch Control dialog](image)

**Fig. 2.3.-2  Main view of a control dialog**

You can switch between the main view and the advanced view by clicking the >> and << buttons in the upper right corner of the Switch Control dialog.
2.3.1. Adding note marker

You can add a note marker to the process display to point out some important information, for example if a line is under construction. You can freely edit the note marker comment (add, delete, move); it does not affect the real process.

To add a note marker, select Tools > Note Marker and select the color for the comment. You should use the colors according to the importance of the comment.

![Image of adding note marker](image)

The available colors are:

- Symbol 1 (Yellow)
- Symbol 2 (Red)
- Symbol 3 (Green)
- Symbol 4 (Magenta)
- Symbol 5 (Cyan)

The note marker object is created to the center of the view and you can move it to the right place with your mouse.

To write a comment:

1. Double-click the note marker object. A Note Marker dialog is displayed.
2. Type a comment to the Note box.
3. Click OK.

Deleting note marker

You can delete a note marker object by opening the Note Marker dialog and selecting Delete. Monitor Pro confirm the operation by displaying a warning dialog. The comment information is removed and the note marker object is deleted from the view.
Moving note marker

You can move the note marker by dragging it with your mouse. When you move the note marker to a new place, new coordinates are saved to the note marker file.

Adding note marker links

You can create links to the files on the server or on your computer by selecting **Links** from the Note Marker dialog. A Note Marker Links dialog is displayed.

You can add new links by browsing the file that you want to link to the comment. When you want to open the file, click **Open** and the linked file opens. For example, if you link an .exe file and open it from the Note Marker Links dialog, the .exe file opens in Windows Notepad.

You can remove the links by selecting the corresponding link and clicking **Remove**.

### 2.4. Monitor Pro layout

![Monitor Pro default layout after the login](image)

**Fig. 2.4.-1  Monitor Pro default layout after the login**

Default Monitor Pro layout contains the following components:

1. Process display name, application name, user name
2. Main menu bar
3. View Info toolbar
4. Latest unacknowledged alarms
5. Shortcut button to reports
6. Busbar Coloring toolbar button
7. Application views
8. Process display area  
9. Status bar  
10. Customization tool  
11. Detach grab handle  

2.4.1. Specifying toolbars

You can add and remove toolbars easily by right-clicking the mouse on the existing toolbar, docking area or standard menu and select or clear the checked commands from the shortcut menu.

By default, Monitor Pro has just a small set of visible prebuilt toolbars. You can modify the layout of Monitor Pro to correspond your requirements. The layout modifications are saved when you logout. The next time you login, your default layout is loaded in the application. By default, Monitor Pro loads and hides some of the toolbars and menus depending on the current view. For example, if you display the Event List, both the Event List menu and Event List toolbars are loaded.

2.4.2. Default menus

The main menubar contains a **Main** menu, **View** menu, **Tools** menu, **Reports** menu and **Help** menu.

The **File** menu provides standard options for working with files.

- **Login/Logout**: Login dialog is displayed.
- **New Window**: Opens a new instance of the Monitor Pro.
- **Back** (Process Display Name): Goes to the previous picture in the navigation history.
- **Active File**: Goes to the current process display view.
- **Forward** (Process Display Name): Goes to the next picture in the navigation history.
- **Open File**: Opens a file (.v or .sd).
- **Exit**: Closes the Monitor Pro.

The **View** menu lets you control the Monitor Pro view.

- **Status bar** (toggle menu item): Toggles the status bar to be visible or invisible.
- **Zoom Control**: Opens the Zoom dialog that contains the zooming and panning functions.
- **Full Screen**: Changes the window’s mode to full screen.

The **Tools** menu lets you use different tools to control different functions.

- **Note Marker**: You can type notes to the process displays in Monitor Pro.
- **Supervision Log**: Opens the supervision log viewer.
- **System Tools**: Opens the Control Panel, Notify, Display Builder, Tool Manager or Busbar Coloring.
- **Options**: Opens the Application Settings dialog, see Section 3.2., Application Settings.
Customize: Opens the Customize dialog, where toolbar buttons and menus can be configured.

Save Layout: Saves the Monitor Pro layout.

Reset Layout: Resets the Monitor Pro layout, which means that the old layout files are deleted, and the new ones localized and taken into use.

The Report menu allows you to view different lists and trends.

Event List: Opens the Event List view.

Alarm List: Opens the Alarm List view.

Blocking List: Opens the Blocking List view.

Trends: Opens the Trend view.

The Help menu provides access to documentation and copyright information.

The shortcut menu is displayed when you right-click the mouse somewhere in the Monitor Pro. The shortcut menu provides a quick way to access the available commands.

2.4.3. Changing application layout

Monitor Pro supports virtually all the Windows Office features. A default layout is loaded when you log into the application for the first time.

Double-clicking on any empty space of the toolbar area of Monitor Pro displays the Customization dialog. You can also use the little arrows in the toolbars to customize toolbars, commands or options. The Customization dialog can also be chosen from the Tools menu by selecting Customize (see Fig. 2.4.3.-1).

You can use the Customization dialog to:

• Add, reset, rename and delete custom toolbars. Old menu items can be deleted and renamed, but new ones cannot be added. Some menu items (for example the ones in Picture Specific menu) and some toolbars (for example the buttons in application specific toolbar) are not customizable because they are always generated on-the-fly.

• Change the command shortcut menu’s caption and style. The command shortcut menu is another way to customize. It is displayed when the Customization dialog is open and you right-click the mouse on the toolbar. You can change the styles to:
  • Default style: Contains both text and icon, if available.
  • Text only: Only text (caption of tool) is shown.
  • Image only: Only the icon is displayed, if available.
  • Image and text: Contains both text and icon, if available.
  • Categorize the action tools and drag-and-drop commands to any toolbar, menu or submenu.
  • Create keyboard shortcuts.
Fig. 2.4.3.-1  **Command context menu while Customization dialog is open.**

When the Customization dialog is open, the toolbar buttons and menu items can be moved around. If the CTRL key is held down while moving the tool, the tool is copied.

The last button on the right of each toolbar is a little arrow button. This quick customization shortcut allows you to show or hide tools from the toolbar without opening the Customization dialog (see Fig. 2.4.3.-2).

Fig. 2.4.3.-2  **Adding and removing tools**

You can also move the buttons between the toolbars without opening the Customization dialog. This can be done by holding down the ALT key and by dragging the buttons to another location. You can also delete the buttons by dragging them away from the toolbar. Pressing CTRL+ALT while moving the button, the button is copied. For the menu items, this is not possible without the Customization dialog.

You can show and hide all the toolbars and menus without the Customization dialog by right-clicking on the main menubar and selecting or deselecting the toolbars (see Fig. 2.4.3.-3). Toolbars are shown depending on the view. For the process graphics
view, Alarm List view, Event List view, Blocking List view or trends view and full screen view there are different configurations depending on which toolbars are shown.

To create a new toolbar:

1. Select New from the Customization dialog
2. Type a new name for the toolbar
3. Click OK. A new toolbar is shown in the Toolbars tab.

When you select the toolbar that you have created, the Rename and Delete buttons become active. You can rename or delete the created toolbar. Clicking the Undo button loads the last saved layout.

Clicking Keyboard in the Toolbars tab, a Keyboard dialog is displayed (see Fig. 2.4.3.-5).
New keyboard shortcuts can be added for the menu items and the toolbars seen in the Categories section.

Categories:
- Built-in Menus: All the top-level menus
- Start with characters mi: All the menus that have sub-menus
- Start with characters tb: All the toolbars (except the user defined toolbars created with Customization dialog)

Commands:
- Sub menu items and buttons of the selected category

To assign a new value to the tool (menu item, button in the toolbar):
1. In the Categories section, select the category in which the menu item or toolbar buttons are located.
2. In the Commands section, select the command (menu item, buttons in the toolbar).
3. Click the Press the new shortcut key box so that the mouse cursor blinks in it and press the new shortcut key combination. The key combination is displayed in the box.
4. Click Assign, and then the shortcut key appears in the Current Keys section.
You can delete the shortcut key by clicking Remove. Clicking Reset All resets the shortcut keys.

In the Commands tab of the Customization dialog, categories and commands are the same as in Toolbars tab (see Fig. 2.4.3.-6).
Fig. 2.4.3.-6 Commands tab of Customization dialog

The Commands can be moved around the same way as on the Toolbars tab. Clicking **Modify Selection** corresponds to the function when a toolbar button or menu item is right-clicked (when the Customization dialog is open) and a similar shortcut menu is displayed. Clicking **Modify Selection** becomes active when a tool is selected either from the menu or from the toolbar.

Personalized menus can be selected into use in the Options tab (see Fig. 2.4.3.-7).

Fig. 2.4.3.-7 Option tab of Customization dialog
Only the most recently used menus are visible. You can clear the memory of the menu usage by clicking **Reset Menu Usage Data**. You can select menu animations or the use of large icons in the Other field.

### Alarm row

The Alarm row gives you a quick notification of an alarming event in the system. The advantage is that it can be noticed easily, and it also instantly tells the operator what has happened and where. With the alarm row the alarms can easily be acknowledged. You can display the Alarm row by selecting it on the Toolbar tab.

![Alarm row](../fig/AlarmRow.png)

#### Fig. 2.4.3.-8 Alarm row

The alarm row shows all the unacknowledged active and inactive alarms in the system. The latest alarm is shown on the top of the list. Any of the alarms shown on the list can be selected to be acknowledged.

The user authorization level has to be at least Control (1) before alarms can be acknowledged (the Alarm row uses authorization group ALARM_HANDLING). For more information on user authorization levels, refer to Section 3.2 User management.

On the Alarm row, active and inactive alarms are separated by showing the alarm text in parentheses (Alarm) if the alarm is inactive. Thereafter, the date and time of the alarm and the object text of the alarming object are presented.

### Status bar

The Status bar, which is located at the bottom of Monitor Pro, shows the current date and time.

![Status bar](../fig/StatusBar.png)

#### Fig. 2.4.3.-9 Status bar

In addition, it shows whether:

- Caps Lock is on/off
- Num Lock is on/off
- Scroll Lock is on/off
- Insert is on/off

### 2.4.4. Resetting application layout

To reset the application layout memory select **Tools > Reset Layout**. This action does not affect the configurations made in the Customization dialog. It resets only the layout, which means that the old layout files are deleted and new ones localized and taken into use.
2.5. Using process lists

There are three types of process lists:

- Alarm List, presents the actual alarm state in the process data base.
- Event List, presents all events reported to the system.
- Blocking List, presents the blocking situation in the process data base.

Some typical blockings are alarm, event and control blocking. These lists are all described in separate chapters, refer to Chapter 5. Event List, Chapter 6. Alarm List and Chapter 7. Blocking List.

2.6. Using reports

You can use the reports in the old Monitor for analyzing sampled measurements. Collected data can be presented in a graphical or numerical form. Typical reports are energy reports, currents, process disturbance reports (for example trippings, earth-faults, overcurrents, auto-reclosures). These reports can be used for analysing fault situations, for improving service and maintenance, but also for normal supervision. For more information on using reports, refer to LIB 510 *4.1 Configuration Manual.
3. Monitor Pro basics

The first time a SYS 600 Monitor is opened for a new application, an initialization procedure is carried out. When a VS monitor is opened for an application, first a MicroSCADA Monitor dialog APL_INIT.VSO is executed from the application directory (APL_). It then triggers further initialization procedures needed by different parts of the MicroSCADA system.

![MicroSCADA Monitor dialog](image)

The following items are created during the initialization procedure of LIB 500:

<table>
<thead>
<tr>
<th>Command procedure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APL_INIT_1</td>
<td>Executed when the application is set hot.</td>
</tr>
<tr>
<td>APL_INIT_2</td>
<td>Executed when application is set hot and reporting has caught real time.</td>
</tr>
<tr>
<td>APL_INIT_H</td>
<td>Executed after take-over in the hot stand-by system.</td>
</tr>
<tr>
<td>LIB4INIT_1</td>
<td>Executed when application is set hot.</td>
</tr>
<tr>
<td>LIB4INIT_2</td>
<td>Executed when application is set hot and reporting has caught real time.</td>
</tr>
<tr>
<td>LIB4INIT_H</td>
<td>Executed after take-over in the hot stand-by system.</td>
</tr>
<tr>
<td>BGU_HDS</td>
<td>Procedure for the LIB 500 Hard Disk Supervision.</td>
</tr>
<tr>
<td>BGU_HDSACT</td>
<td>Procedure is activated when the HD size alarm is activated.</td>
</tr>
<tr>
<td>MON_EVENT</td>
<td>Starts the printing of monitor connection events.</td>
</tr>
</tbody>
</table>
The login dialog will be opened, if the application is prepared for LIB 500 (see Fig. 3.-2). The first user to login an application becomes the System Manager, refer to the authorization levels in Section 3.2. User management. The system manager can then create new users via the User Management picture, which is accessible from the Options menu.
3.1. Options

To define application options, select **Tools > Options**. You can specify application specific options such as:

- Application owner
- First picture shown after login
- Application logo picture
- System location
- System name
- Product info
- Lockout duration
- Language settings
- Daylight Saving time
- Process control
- Show object ID
- HD space alarm
- Report Settings
- Switch device presentation
3.1.1. Application settings

You can modify the application settings by selecting the Application Setting tab. The application name is shown in the title bar of the Option dialog. In practice, this is the name of the customer to whom this product is licensed. The name of the application cannot be changed in the Application Settings tab (see Fig. 3.1.1.-1).

![Application settings](AplSet_b)

You can define a certain process display to be shown after logging by browsing the process display to the First picture shown after login box. This picture can be any .v or .sd type of picture.

System location is an attribute that needs to be configured. This defines whether MicroSCADA is running as Network Control Center (NCC) or Substation Control System (SCS).

To be able to make any changes in the application settings, the authorization level must be System Manager (5), refer to Section 3.2. User management. The only exception to this rule is the monitor language that can be set by all the users.

To save the new settings, click **Save** or **Apply**. Clicking **Cancel** returns the previous settings.
3.1.2. Language settings

You can modify the language settings in the Language Setting tab. You can select the language in the drop-down list (see Fig. 3.1.2.-1). The default language is English and the following customized languages (if any) are defined as local languages.

The monitor language changes the language used in pictures and dialogs. The selected language will remain active as long as the application in the monitor is open.

When printing to an event printer, the application language is used. The application language is the same for all the users within the same application regardless of the used monitor language. The change of the application language will be valid until it is altered again in the Language Settings. The application language does not have any effect on the language shown in the monitors.

The monitor language and the application language are selected from the drop-down list. To save the new settings, click Save or Apply. Clicking Cancel returns the previous settings.

![Language Settings tab](LangSet_b)

Fig. 3.1.2.-1 Language Settings tab

When copying a user profile from an existing user to a new user, the user language is also copied.
### Lockout duration

You can set the lockout duration time in the Lockout Duration tab. The lockout duration sets the session length (see Fig. 3.1.3.-1). When the lockout duration time expires, the authorization level is reset to View (0), refer to the authorization levels in Section 3.2. User management. The lockout duration time is given in hours (from 1 to 254).

**Fig. 3.1.3.-1  Lockout Duration tab**

The program informs you about the authorization level reset. The notification regarding the expiring time is displayed according to the times defined in the Session expiring notify times field. The times are given in minutes before the resetting. A maximum of five different notifications can be given.

If you change the lockout duration or session length notify times, the new values are not taken into use until the next login.

The session duration can be activated or deactivated with the Enable and Disable lockout duration check boxes. If the session duration is in use, the session duration time and the session expiring notify times can be changed. Otherwise the session duration is unlimited and the session expiring notify times are not accessible. To save the new settings, click **Save** or **Apply**. Clicking **Cancel** returns the previous settings.
3.1.4. Daylight settings

You can set the daylight saving time on the Daylight Setting tab. If the daylight saving time function is set in use, the system time will be automatically adjusted to the normal time and to the daylight saving time (see Fig. 3.1.4.-1).

![Daylight Settings tab](image)

Fig. 3.1.4.-1 Daylight Settings tab

When the operating system changes the time to daylight saving time or standard time, there might be application specific actions to be done in MicroSCADA. If adjusting applications for daylight saving is enabled, the event is set to the Event List and event printer.

You can create two command procedures for application specific programming:

- BGU_TIMEF0:C is executed when the clock is moved forwards
- BGU_TIMEB0:C is executed when the clock is moved backwards

The point of execution time is 20 seconds after the change. Command procedures mentioned above are executed in each application found.

It is recommended to define the point of the time change few minutes over an even hour in order to avoid unnecessary system load.

When the Automatically adjust applications for daylight saving changes option is enabled, the application handling the actions can be selected from the drop-down list. To save the new settings, click Save or Apply. Clicking Cancel returns the previous settings.
3.1.5. **Process control settings**

You can define the process control settings on the Process Control tab. You can set the behaviour of printing and the MV process control when operations are executed (see Fig. 3.1.5.-1). When the Close dialog after execution option is selected, the control dialogs, for example breaker dialogs, are closed after the operation is done.

![Process Control tab](image)

To activate or deactivate the options, select or clear the check boxes. To save the new settings, click **Save** or **Apply**. Clicking **Cancel** returns the previous settings.
3.1.6. Show object identification

To define object identification settings, select the Show Object ID tab. The OI attribute settings tab defines the parts of the OI attribute that are to be shown in Alarm Lists, Event List, dialogs of MV process, and so on.

The options between the first shown object and the last shown object cannot be left out. For example, if you select substation and device to be shown, the bay object is selected as well (see Fig. 3.1.6.-1).

Fig. 3.1.6.-1  Show Object ID tab

To save the new settings, click Save or Apply. Clicking Cancel returns the previous settings.
3.1.7. HD space alarm

You can define the hard disk supervision function on the HD Space Alarm tab to supervise the free hard disk space. With this function you receive an early warning if there is a risk of running out of space on the hard disk (see Fig. 3.1.7.-1).

You can give a lower alarm limit for the disk space by selecting the alarm limit from the Alarm limit drop-down list. You can also type the required limit. The limit is presented as mega bytes.

If you set the alarm limit to zero (0) or select Not in use from the drop-down list, the hard disk supervision is stopped. A warning limit is calculated from the alarm limit. The warning limit is 10% higher than the low alarm limit.

To save the new settings, click Save or Apply. Clicking Cancel returns the previous settings.
3.1.8. Report settings

You can define the report settings on the Report Settings tab. The report settings function defines the application specific parameters used by the LIB 510 Measurement Reports 2 (see Fig. 3.1.8.-1). For more information on configuring LIB 510, refer to the LIB 510 *4.1 Configuration Manual.

Before defining the reports, the following definitions should be settled:

**Table 3.1.8-1 Report settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Explanation</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base Period (min) *</td>
<td>Defines a period cycle to be used within the reports. The period cycle can be either 15 min., 30 min. or 60 min.</td>
<td>60 min.</td>
</tr>
<tr>
<td>Base Period History Length (years) *</td>
<td>Defines the length of the period values history in years. The history length can be from 1 year up to 5 years.</td>
<td>2 years</td>
</tr>
<tr>
<td>Forecast Period (days)</td>
<td>Defines the length of the forecast period area in days. The forecast period area can be used within the reports, for example for monitoring predicted future values. The forecast period area can be up to 15 days.</td>
<td>0 days</td>
</tr>
<tr>
<td>Begin Of Day (hour) *</td>
<td>Defines the beginning of the report day in hours after midnight.</td>
<td>0</td>
</tr>
<tr>
<td>Begin Of Week</td>
<td>Defines the beginning of the report week.</td>
<td>Monday</td>
</tr>
<tr>
<td>Default Sampling Frequency (min) *</td>
<td>Defines a sampling cycle to be used within the reports.</td>
<td>3 min.</td>
</tr>
</tbody>
</table>
Each parameter can be selected from the drop-down lists, where all the available choices are listed. To save the new settings, click **Save** or **Apply**. Clicking **Cancel** returns the previous settings.

If there are any previous report settings made within the application, the existing report database will be reset and all data will be lost. The report database is checked during the saving and if resetting is needed, an information dialog will be shown to confirm or cancel the saving.

## 3.2. User management

This section describes the elements and functions of the user management. You can change the user rights if your authorization level is System manager (5).

With the User Management tool you can define users and access rights with authorization levels. In the LIB 500 applications the standard functions in the process displays can be freely grouped into authorization groups. This means that you can have different authorization levels for different apparatus. Users can also be defined to have different authorization levels for different tools, substations, and so on.

The authorization levels used:

- **View (0)** = Not authorized to make operations
- **Control (1)** = Authorized to make operations
- **Engineering (2)** = All rights, but user definition
- **Reserved (3)** = Reserved for the future use
- **Reserved (4)** = Reserved for the future use
- **System manager (5)** = All rights

The user levels of the selected user are displayed in the Main View. The levels can be directly modified. Note that the GENERAL level of the system manager cannot be changed. Valid values are 0 (View), 1 (Control) and 2 (Engineering).

The modifications cannot be taken into use until they are saved in the User Management picture.

The whole login mechanism can be disabled by the system manager by deactivating the user management and authorization mechanism. That way the Login dialog is not shown at the start-up. In that case all authorization rights are granted.
To disable the authorization, clear the Disable authorisation mechanism check box (see Fig. 3.2.-1).

![Enable/Disable authorization mechanism](Disable_UM.tif)

**Disable authorisation mechanism**

**Fig. 3.2.-1 Disabling authorization mechanism**

### 3.2.1. Defining user interface

You can select the language from a list of supported languages. The default language is English. For more information, refer to Section 3.1.2. Language settings.

The authorization levels of the selected users are displayed. The levels can be directly modified by the system manager.

The GENERAL level for the system manager cannot be changed. You can change the levels by selecting the authorization group(s) from the list and selecting a new authorization level from the list box below the list. The authorization level is shown under the authorization level column.

The User list shows the users and you can define their user language from the list box of supported languages.

Various tools and functions can be accessed from the toolbar and menus, and also with keyboard shortcuts. Fig. 3.2.1.-1 shows the user management interface and its elements.

![User Management](User_manage.tif)

**User Management**

**Fig. 3.2.1.-1 User Management**
The User Management window contains the following menus to operate:
The **File** menu contains the main functions for saving, printing and exiting. The Print command prints the following informations:

- User
- User's language
- Authorization group list
- Authorization level list

The **Edit** menu enables and disables the viewing of the toolbar buttons.

The **Tools** menu contains the tools for user management.

The **Help** menu contains general information on user management help.

The toolbar contains shortcuts for fast access to the frequently used functions.

### 3.2.2. Adding user

The system manager can add users from the Add User dialog.

To add a new user:

1. Select **Tools > Add User**.
2. Type a user name. The name must not contain special characters and it must not consist of two characters followed by a number. Also, the name cannot begin with a number.
3. You can copy the authority level from another user (not from the system manager) by selecting the source.
4. Click **Apply** to save the user information. Clicking **Done** closes the dialog without saving.

The password for the new user is enter before the user changes it. You can see the run time help by clicking Help.

The modifications do not become active until you save the User Management dialog.
3.2.3. **Removing user**

If you have system manager rights, you can remove users.

To remove a user:
1. Select **Tools > Remove User**.
2. Select the user that you want to delete from the Remove selected user box.
3. Click **Remove**. The system manager cannot be removed. Clicking **Done** closes the dialog.

You can see the run time help by clicking Help.

![Removing user](Rem_User.png)

**Fig. 3.2.3.-1 Removing user**

The modifications do not become active until you save the User Management dialog.

3.2.4. **Adding group**

To add a new group:
1. Select **Tools > Add Group**.
2. Type a group name. The name must not contain special characters and it must not consist of two characters followed by a number. Also, the name cannot begin with a number.
3. You can copy the authority level from another group (not from the GENERAL group) by selecting the source. If the user levels are not copied from another group, then all the users get view rights (0) as default.
4. Click **Apply** to save the user information. Clicking **Done** closes the dialog without saving.

You can see the run time help by clicking Help.
3.2.5. Removing group

Only the system manager can remove authorization groups.

To remove group:

1. Select `Tools > Remove Group`.
2. Select the group that you want to delete from the Remove selected group box.
3. Click `Remove`. The group GENERAL cannot be removed.

All the tools and standard picture functions configured to the group will automatically start using the definitions of the GENERAL group. Clicking `Done` closes the dialog. You can see the run time help by clicking `Help`.

Fig. 3.2.5.-1 Removing group

The modifications do not become active until you save the User Management dialog.
3.2.6. Changing password

All users can change their own password.

To change the password:
1. Type the old password.
2. Type the new password and confirm it.
3. Click OK. The new password is taken into use right away.

![Change Password](image)

*Fig. 3.2.6.-1 Changing password*

The new password has to be given twice to be confirmed.

The modifications do not become active until you save the User Management dialog.

3.2.7. Defining view monitors

If you have the system manager rights, you can restrict the authorization level to view (0) for all the users logging in from defined work places.

To define view monitor:
1. Select Tools > Define view Monitors.
2. Click Add to add a system device name to the list.
3. You can remove the monitors from the list by selecting the monitor and clicking Remove.
4. Click OK. The monitors on the list are defined to be view monitors.

You can see the run time help by clicking Help.
3.3. Calendar

MicroSCADA Calendar is a tool for defining features or activities that depend on time. Calendar is installed automatically with the LIB 500 Backbone.

Time periods can be applied for example to define day and night tariffs, specifying contracts that are in force, general holidays, and so on. Calendar data can then be utilized in the other MicroSCADA pictures, for example in the report tool.

It is possible to use the Calendar to define command procedures which are to be run by MicroSCADA on a defined day or on all days that are marked as a certain type of day. Default day settings are available either for all days or for workdays and Sundays separately.

Settings that determine the operations or properties which will take place at a certain moment of time, are defined in a day specific graphical attribute list. The attribute list is maintained by using an attribute tool that is integrated into the calendar. Each attribute has a graphical user interface of its own on the list.

Individual days can be configured independently with the attribute tool to have day specific attributes. The attribute list can also be defined for the day type. The day type is a logical name that can be used for connecting an attribute list to a day. All attributes defined for a day type are then applied to all days that have a link to the day type. Fast modifications can be performed simultaneously for several days by using the predefined day types. New day types can be created freely.

3.3.1. Opening Calendar

The Calendar can be started in the application main picture. Select Calendar in the Tools menu.

The modifications do not become active until you save the User Management dialog.
The main calendar view is used for browsing general calendar information. The calendar is divided into 12 months, one in every tabbed page. You can select the month by clicking the corresponding tab. The current day is marked with a red box (see Fig. 3.3.1.-1).

In the toolbar there are shortcut buttons to the most used commands. The commands are from left to right:

- Function
- Go to today
- Previous year
- Next year
- Go to year X
- Select the day of the week
- Select the week
- Select the month
- Add the day type

Fig. 3.3.1.-1 The Calendar tool
3.3.2. Making selections

Multiple selections can be made when the Attribute dialog is not open. Close it before making a multiple selection.

- Click a day in the Calendar to add the day into the selection.
- To deselect days, single-click the day label again. The current label state can also be changed by pressing the Space bar. The opening of the Attribute dialog by double-clicking a day label also removes all other days selected except the current day.
- Selection can be expanded by using the selection buttons in the toolbar.
- Any day type can be added to the selection.
- Any day type setting can be removed from the selection.

3.3.3. Adding day type to group of days

When a selection is made, a day type can be added to the day group. Select a day type on the day type list and click Set. When the button is clicked, all the selection marks disappear and the number fonts of the selected day change to bold to indicate that they are provided with the relevant settings. If the day color is set on the day type attribute list, all the days are marked with that color.

To remove a day type setting from a day, make a multiple selection, select the day type to be removed and click Remove. Another way to remove a day type setting is to open the Edit day attributes dialog and to delete the corresponding day type block from the attribute list.

3.3.4. Setting day type attributes

To set a day type attribute, double-click the day type item on the list containing the day type names. This opens the attribute dialog.

The day type attributes are defined in a similar way as the day attributes. The only difference is the text box in the upper part of the dialog where the type name is displayed. This name is also visible on the list of the main calendar view.

Changes made in the day type attributes are applied to all the days defined as that day type.

3.3.5. Saving attributes

You can save the attributes by clicking Apply. If you do not click Apply and you select another day, all the blocks containing invalid data will be deleted. It is recommended to click Apply to check the data validity before moving to another day or closing the dialog.

Saving is also done when Go to today is clicked. This is the most recommended way to save changes to the day or to day type attributes. When the Attribute dialog is closed, data validity is checked and valid data is saved.

3.3.6. Changing current time

To step one year forward, click Next year on the toolbar. Similarly, to move to the previous year, click Previous year. To move to any year between the years 1978-2045, click the Go to year X and type the year into the Input dialog.
3.3.7. Setting day attributes

You can set the day and the day type attributes by double-clicking the day label (day number). The Edit day attributes dialog is then displayed (see Fig. 3.3.7.-1).

To add a new day attribute:

1. Click **New** from the Edit day attributes dialog. A new block is added to the attribute list.
2. New attributes can be added into the day profile by clicking **New**. In the subsequent dialog box, the type of the new attribute can be selected.
3. Click **Apply** after you have edited the day attributes. The program checks the validity of the data and saves the changes. If data is not valid, an error message will be displayed.

**Delete** removes all the marked blocks. After you have saved the attributes, you can close the dialog by clicking **Close**.

**Help** Displays the attribute tool help text.

![Edit Day Attributes Dialog](Edit_Day_Attrib_b)

**Fig. 3.3.7.-1**  Edit day attributes dialog

A maximum of 10 attributes per day (or per day type) is allowed.

**Available attributes**

The following attributes are used in the attribute tool. Some of the blocks are available only for the day attribute list. Every block has a check box in the upper right corner. It is used for selecting the block.
1. Assign type (see Fig. 3.3.7.-2). Inserting this block into the attribute list of a day connects the day to a day type. All the settings made for the named day type are then applied to the current day. This block is available only for a day, not for a day type. All the day types that are defined in the Options tool are visible in the drop-down list.

![Assign type dialog](assign.png)

Fig. 3.3.7.-2 The Assign type dialog

2. Day name (see Fig. 3.3.7.-3). A day is named with a given text string. The day color in the main calendar view is selected with the help of the drop-down list. The block is available both for days and day types.

![Day name dialog](day_name.png)

Fig. 3.3.7.-3 The Day name dialog

3. Run command procedure (see Fig. 3.3.7.-4). It executes a command procedure at a given time of day. The running time is given with the time resolution of 1 minute. This block is available both for days and for day types.

![Run command procedure dialog](run.png)

Fig. 3.3.7.-4 The Run command procedure dialog

4. Time period start/stop (see Fig. 3.3.7.-5). This block is used to define periods which are in effect for several days. The block is available only for days.

![Time period start/stop dialog](time_period.png)

Fig. 3.3.7.-5 The Time period start/stop dialog
5. In-day period (see Fig. 3.3.7.-6). The block defines a period that starts and ends during the current day 0:00-23:59. Time resolution is 1 minute. This block is available both for days and day types.

![In-day period dialog](calendar_opt_b)

**Fig. 3.3.7.-6** The In-day period dialog

### 3.3.8. Setting calendar options

You can modify the Calendar Option dialog by selecting **Edit > Options** from the Calendar window. The dialog consists of three tabbed pages:

- General Calendar options
- Procedures
- Day types

#### 3.3.8.1. General calendar options

![General calendar options](calendar_opt_b)

**Fig. 3.3.8.1.-1** General calendar options
To add more day types into the combo box, select the Day types tab and add new types on the list.

### Procedures

**Fig. 3.3.8.2.-1 Allowed procedures**

Allowed procedures can be defined in the Procedures tab of the Calendar Options dialog. On the right side of the Procedures tab are all the command procedures that exist in the system, on the left side are the command procedures that are allowed in the calendar.

To add new procedures to the list of allowed procedures, select a procedure from the All procedures list and click the << button. To remove a procedure from the list of allowed procedures, select a procedure and click the >> button.

Allowed procedures are used by the Run command procedure calendar attribute. Only allowed procedures are included in the combo box of the attribute (see Fig. 3.3.7.-4).

You are required to have at least the engineering authorization level (2) to be able to modify the list of allowed procedures. The list is initially empty but it will be filled according to your above-mentioned actions.
3.3.8.3. Day types

To add a new day type:
1. Click the **Add** button.
2. Type a name for the day type. The day type is displayed on the list.
3. Save the changes by clicking **OK**.

To remove a day type, select a day type from the list and click **Remove**.

If you remove a day type, all references to the day type are deleted from the calendar database.
4. **Process controlling**

This chapter describes the generic control dialogs in SYS 600 SA LIB. These dialogs provide fast and easy access to the device status and to the single devices in a substation. The Control dialog combines different kind of information, depending on the object.

Control dialogs interact with standard objects created with Object Navigator by using the SA LIB standard functions. Control dialogs are generic and they have the same user-interface appearance, independent on the IED and the communication protocol defined in standard object configuration.

4.1. **Station Local/Remote control**

The station control shows the operator location information of the substation, that is, whether the control is authorized from the station locally or from an external control center. In Station L/R switch dialog you can set the state to Station or Remote.

![Station Local/Remote switch dialog](image)

*Fig. 4.1.-1 Main tab of Station Local/Remote switch dialog*

The Main tab of the dialog shows the object name and the selection for operator location. You can select the operator location by selecting the right option button. The available options depend on the object configuration. Unavailable options are dimmed.

Select the corresponding option for operator location (for example Remote). Close the control dialog by clicking the **Exit** button.
The Messages tab (Fig. 4.1.-2) shows different messages concerning the object. A message is shown, for example, if the object is simulated or the information of the physical local/remote key position is unknown.

**Fig. 4.1.-2  Messages tab of Station L/R switch dialog**

Different blockings concerning the process object that belong to the station are shown and controlled in the Blocking tab, see Fig. 4.1.-3.

**Fig. 4.1.-3  Blocking tab of Station L/R switch dialog**
After selection (multiple selections allowed), click **Apply** for making the changes. Click **Cancel** to discard the changes made in this dialog. Click **Refresh** to update the blocking status in case it has been changed elsewhere in the system.

The alarms are shown on the Alarms tab, see Fig. 4.1.-4. To acknowledge alarms click **Ack. All** or **Ack selected**.

---

**4.2. Bay Local/Remote control**

The Bay L/R control shows the operator location information of a bay in a substation, that is, whether the control is authorized from the bay unit locally or remotely over a communication link (for example station HSI).

If the Bay L/R switch is remotely controllable, it is possible to change the switch state from the control dialog. The Bay Local/Remote switch can be one of the following:

- Switch
- Selection on the relays
- Local setting in SYS 600

The Main tab of the Bay L/R switch dialog (Fig. 4.2.-1) shows the object name and the selection for the operator location. You can select the operator location by selecting the corresponding option. The available options depend on the object configuration, unavailable options are dimmed.
Select the corresponding option for operator location (for example Remote). Close the control dialog by clicking **Exit**.

**Fig. 4.2.-1**  Main tab of Bay L/R switch dialog

The Messages tab (Fig. 4.2.-2) shows the different messages concerning the selected object. A message is shown, for example, if the object is simulated or the information of the physical local/remote key position is unknown.

**Fig. 4.2.-2**  Messages tab of Bay L/R switch dialog
Different blockings concerning the process objects that belong to the bay are shown and controlled in the Blocking tab, see Fig. 4.2.-3.

**Fig. 4.2.-3**  Blocking tab of Bay L/R switch dialog

After selection (multiple selection allowed) click **Apply** for making the changes. Click **Cancel** to restore the changes made. Click **Refresh** to update the status of the blocking in case it has been changed elsewhere in the system.

The alarms are shown on the Alarms tab, see Fig. 4.2.-4. To acknowledge alarms click **Ack. All** or **Ack selected**.

**Fig. 4.2.-4**  Alarms tab of Bay L/R switch dialog
4.3. **Switch control**

Switch control dialogs can be used to show current state and status of a switch device object. It is also used for operating the switch device. You can open the Switch Control dialog by double-clicking the objects. The same dialog operates with breakers, disconnectors and earthing disconnectors. The available functions are based on the configuration definition of the corresponding SA LIB standard object.

There are several tabs on this dialog. You can see the object identification (station, bay and the object) on every tab. The tabbed pages in the Switch Control dialog are divided into main view and advanced view. In the main view it is only possible to open and close the switch. You can open the advanced view by clicking the >> button in the upper right corner of the Switch Control dialog.

On the Main tab is shown the object status. The object status can be, for example, authorization, blocking information and reservation information, as well as potential problems on the communication link acquiring the correct status. Possible errors during the operation appear in the Object status field of the Switch state tab. Close the dialog by clicking **Exit** or click the icon on the upper-right corner of the dialog.

![Fig. 4.3.-1 Main view of the Switch control dialog](image)

If you open or close the disconnector the program asks you to verify the control operation. In case of an error in selection, the error message is shown in the Object status box.

If controlling is possible, the **Open Disconnector** or **Close Disconnector** buttons are active. Note that once the selection of the control command is done it may include several steps on the process to be controlled (for example interlocking conditions are checked). These depend on the actual configuration of the process devices.

In the advanced view, there are tabbed pages for blockings, forced operation and simulation.
### 4.3.1. Blockings

In the Blocking tab of the Switch Control dialog (Fig. 4.3.1.-1), the different blockings concerning the process objects that hold information about switch state are shown and controlled. After selection (multiple selection allowed), click the **Apply** for making the changes. Clicking **Cancel** discards the changes made. To update the status of the blocking (in case it has been changed elsewhere in the system), click **Refresh**.

**Fig. 4.3.1.-1**  
*Advanced view of Blocking tab*
4.3.2. **Forced operations**

On Forced operation tab (see Fig. 4.3.2.-1), the internal blockings of SYS 600 and SA LIB control blockings can be bypassed. You can force objects to operate on your command even if another user is connected to them or the function is normally not permitted. However, this does not disable any interlockings or other IED measures, that is, no special bypass messages are sent to the IEDs.

![Forced operation tab](image)

**Fig. 4.3.2.-1 Forced operation tab**

If an object is selected on the current or on another monitor, clicking **Release device reservation** resets the selection and you have the authority for controlling the object. This is possible only if the object selection is simulated in the MicroSCADA process database, that is, breaker command event (index 20) is not connected to process.

You can use the **Forced open/close control** button to enable the control buttons to simulate the controlling of the switch. In this case the controlling is done as normal control, that is, without bypassing options. **Forced open/close control** button can be dimmed because of various reasons, for example the switch is in the middle position.

You can configure two different device level overrides in standard configuration tool. When the Control with interlocking bypass option is selected, the corresponding selection can be done in the control dialog. If you select the Control with synchrocheck bypass option, an additional process object for synchrocheck indication is created.

The interlocking and synchrocheck bypass functions can only be used with IEC 61850 protocol.
If the switch device is interlocked or synchrocheck inhibits the control, you can select the corresponding check box and control the switch device in a normal way with the Open Disconnector and Close Disconnector buttons. The Event List shows that controlling was done with the bypass option.

The following table presents the control type for the switch device:

**Table 4.3.2-1  ABBCommandBitmask**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Value/Value range</th>
<th>M/O/C</th>
<th>OPC Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>NormalControl</td>
<td>1bit</td>
<td>FALSE (0) I TRUE (1)</td>
<td>M</td>
<td>0</td>
</tr>
<tr>
<td>InterlockOverride</td>
<td>1bit</td>
<td>FALSE (0) I TRUE (1)</td>
<td>M</td>
<td>1</td>
</tr>
<tr>
<td>SynchrocheckOverride</td>
<td>1bit</td>
<td>FALSE (0) I TRUE (1)</td>
<td>M</td>
<td>2</td>
</tr>
<tr>
<td>TestCommand</td>
<td>1bit</td>
<td>FALSE (0) I TRUE (1)</td>
<td>M</td>
<td>3</td>
</tr>
<tr>
<td>Originator</td>
<td>4bit</td>
<td>not-supported (0) I bay-control (1) I station-control (2) I remote-control (3) I automatic-bay (4) I automatic-station (5) I automatic-remote (6) I maintenance (7) I process (8)</td>
<td>M</td>
<td>4-7</td>
</tr>
<tr>
<td>ControlValue</td>
<td>nbit</td>
<td></td>
<td>M</td>
<td>8-31</td>
</tr>
</tbody>
</table>

a. NormalControl: true = normal operation, false = inverse operation (for example On/Off)
b. InterlockOverride: true = interlockcheck > false
c. SynchrocheckOverride: true = synchrocheck > false
d. TestCommand: true = test command
e. Originator: Command originator (= Originator.orCat)
4.3.3. Simulation

The state of the switch object can be simulated on the Simulation tab (see Fig. 4.3.3.-1). The state is then indicated on process displays with blue color and appropriate messages on control dialogs. Simulation can not be deactivated if there is no process communication for the corresponding process object.

After the selection, click Apply to apply the changes. Clicking Cancel discards the changes made. By clicking Refresh, the status of simulation is updated in case has been changed elsewhere in the system.
4.3.4. Alarms

The alarms are shown on the Alarms tab, see Fig. 4.3.4.-1. To acknowledge alarms click **Ack. All** or **Ack selected**.

![Fig. 4.3.4.-1 Advanced view of Alarms tab](image_url)
### 4.3.5. Auto-reclose

In case auto-reclose function is configured for the switch object, the messages from the function is shown in the Object status box of the Reclosing tab (see Fig. 4.3.5.-1). Interrupt an on-going sequence by clicking **Interrupt AR sequence**. This button is dimmed if the corresponding function is not available.

![Advanced view of Reclosing tab](image)

**Fig. 4.3.5.-1  Advanced view of Reclosing tab**
4.4. **Transformer voltage control**

Tap changer control dialog shows the current state of the transformer voltage controller, and can be used for operating it as well. The available functions are based on the configuration definition of the corresponding SA LIB standard object.

The identification information (station, bay, object) is shown in box on the Main tab, (see Fig. 4.4.-1). Set the control operation mode by clicking the corresponding option under the Operation mode. The options are available depending on object configuration, the unavailable options are dimmed. Confirm the selection by clicking the **Execute** button. Cancel the selection by clicking the **Cancel** button. The symbol buttons are presented in the beginning of Chapter 4. Process controlling).

![Tap changer control dialog, main tab](image)

**Fig. 4.4.-1  Tap changer control dialog, main tab**

Voltage or tap positions can be controlled, if the configuration and status allow it. You can control the voltage and tap values by using the **Lower** and **Raise** buttons. In the Main tab, you can set the current values of tap position and voltage as well.
To set Reference voltage:

1. Click **Set** and the Reference voltage setting dialog opens.
2. Type a new value in kilovolts to the New reference voltage box.
3. Click **OK**.

![Reference voltage setting dialog](A050134)

*Fig. 4.4.-2 Reference voltage setting dialog*

The unit changes dynamically according to the unit defined in the ST attribute of the reference voltage process object.

Reference voltage setting requires the following:

- Process object to set reference voltage value (command object)
- Process object for indication of reference voltage
- User interface support for setting the reference value

To set Tap value:

1. Click **Set** and the Tap value setting dialog opens.

![Tap value setting dialog](A050135)

*Fig. 4.4.-3 Tap value setting dialog*

2. Type a new value in kilovolts to the New reference voltage box.
3. Click **OK**.

Tap value setting requires the following:

- Process object to set reference tap value (command object)
- Process object for indication of tap value
- User interface support for setting the tap value. This can be implemented in control dialog by adding a text box where numerical tap value can be written.

The **Set** is not visible if numerical command object does not exist.

The Messages tab shows different messages concerning the object, for example if the object is simulated, or the information of the voltage controller is unknown.

On the Operation tab you can select the operation mode (see Fig. 4.4.-4).
Different blockings concerning the process objects holding information about the voltage controller are shown and controlled in Blocking tab (Fig. 4.4.-5). After selection (multiple selections allowed), click **OK** to apply the changes. Clicking **Cancel** discards the changes made. Click **Refresh** to update the status of the blocking in case it has been changed elsewhere in the system.
If an object is selected on the current or on another monitor, clicking Release device reservation resets the selection and you have the authority for controlling the object.

*Fig. 4.4.-6 Tap changer control dialog, Forced operation tab*
4.5. Measurement control

You can view the measured values in numeric and bar graph presentations in the Measurement dialog. The values and bar graphs are colored based on the state and status of the measured signal.

You can show and hide the bar graph presentation by clicking the button in the Measurement dialog (see Fig. 4.5.-1).

You can open the advanced view by clicking the >> button in the upper right corner of the Measurement dialog. The number of shown measurands depends on the configuration of the measurement object (see Fig. 4.5.-2).

In the Measurement dialog you can monitor:

- 1 to 4 measurement values including measured values and unit information
- 1 to 4 state and/or status indicators (text and coloring)
- 1 to 4 alarm acknowledgement buttons (blinking button, visible if the measurement has an unacknowledged alarm, confirmation dialog for acknowledgement of the alarm)
- 1 to 4 optional bar graphs (The bar graph is not shown, if a measurement does not have alarm or warning limits, for example, it is a pulse counter)
- The advanced view includes tabbed pages for measured values, limits, zero deadband supervision, blocking, object messages and alarms.

If the information on the tab is related to one measurand only, the option buttons to select the measurand become visible (see Fig. 4.5.-2). Otherwise the option buttons are hidden.
The different colors on the dialog are based on the selections made in the SYS600_colors.clut Color LookUp Table file. You need at least Control (1) rights to acknowledge alarms, make blockings, reset minimum and maximum values and set simulation values, limits and deadband supervision.

The maximum value that can be shown in the bar graph is high alarm limit +10% of the difference between high and low alarm limits. The minimum value that can be shown in the bar graph is low alarm limit -10% of the difference between high and low alarm limits. If the measured value is below the minimum value or above the maximum value, the symbol has been struck through to indicate that the value cannot be seen in this bar graph with the current limit settings.

On the Measured Values tab of the Measurement dialog you can:

- See the selected measured value and timestamp
- Reset the min value and timestamp
- Reset the max value and timestamp
- Reset the frozen value and timestamp
- Simulate a value
- Check that the simulated value is valid

![Measurement dialog](image)

Fig. 4.5.-2 Advanced view with measured value and simulation
The simulated value entered is validated at first. If the simulated value is not valid, the Value box is displayed in red color (see Fig. 4.5.-3).

Fig. 4.5.-3 Invalid simulated value

On the Limits tab you can:

- Set the high and low alarm and warning limit values. The maximum and minimum values are calculated like in the bar graphs (the limits cannot be set, for example, for pulse counters).
- Copy and paste the limit values by right-clicking on the limits frame

A warning message will be shown if the limits in the process have been changed during the edition of the new limits in the Measurement dialog.

Fig. 4.5.-4 Limits tab
The limit values entered are validated at first. If, for example, the high warning limit is bigger than the high alarm limit, the inappropriate limits are shown in yellow color (see Fig. 4.5.-5).

Fig. 4.5.-5 Inappropriate limits

If a limit is not a number, the invalid limit is shown in red color (see Fig. 4.5.-6).

Fig. 4.5.-6 Invalid limit value

On the Deadband tab you can set the zero deadband supervision
A warning message is shown if the deadband value in the process is changed during the edition of the new setting value in the Measurement dialog.

**Fig. 4.5.-7  Deadband tab**

The deadband limit value entered is validated at first. If you set an invalid deadband value, the invalid limit is shown in red color (see Fig. 4.5.-8).

**Fig. 4.5.-8  Invalid deadband setting value**
On the Blockings tab you can block the measurements.

Fig. 4.5.-9  Blocking tab
On the Messages tab you can see the object messages of a selected measurand.

*Fig. 4.5.-10 Messages tab*
On the Alarms tab you can see the alarms of the measurand.

![Extended view with alarms](image)

**Fig. 4.5.-11 Extended view with alarms**

### 4.6. Busbar Coloring

The busbar coloring in SYS 600 Monitor Pro and the Display Builder can be used to indicate the status of busbar sections in several different ways. It can indicate which busbar sections are powered, unpowered or in certain other states, or more accurately which voltage level each busbar section has. Alternatively, each voltage source or voltage source type can have a color that is used for sections they are connected to. Busbar coloring may also be used to indicate situations where two or more voltage sources form a loop.

To define busbar coloring settings, select **Actions > Busbar Coloring**. The following dialog is displayed.
Fig. 4.6.-1  Busbar Coloring Settings dialog

On the General tab you can define the busbar coloring settings to use in the current display. You can save the settings to be used as default by clicking **Set as defaults**. You restore the saved settings by clicking **Restore defaults**.

On the Colorings modes tab you can specify what kind of color coding the Display Builder uses for powered line segments.

Fig. 4.6.-2  Coloring modes
On the Colors tab you can order the priority of the voltage source colors. The device for the highest priority is on top of the list. To change the priority order, select a device from the list and click the arrow buttons on the right to change the order.

![Busbar Coloring Settings](image)

**Fig. 4.6.-3 Priority of voltage colors**

For more information on busbar coloring, refer to SYS 600 *9.1 Process Display Design manual.
5. Event List

With the Event List you can monitor the information about events occurring in the system. Thus, you can make the right decisions and verify that taken measures have been successfully performed. You can also receive information about activities carried out by other users, operations of objects, acknowledging of alarms, editing of limit values, logging in, and so on (see Fig. 5.-1).

The Event List presents the data in a structured way for the user’s convenience. Each event is normally presented by displaying an event text line, which describes the cause of the event in the process. Event text lines normally consist of a time stamp, object identification, a signal text and a text indicating the status.

The Event List contains the following features and options:

- Unlimited storage of events (limited by disk capacity)
- Configurable layout: columns, fonts, toolbars, coloring, and so on.
- Configurable coloring of events
- Configurable scrolling behavior

Fig. 5.-1 Event List main view

The Event List presents the data in a structured way for the user’s convenience. Each event is normally presented by displaying an event text line, which describes the cause of the event in the process. Event text lines normally consist of a time stamp, object identification, a signal text and a text indicating the status.
• Configurable presentation modes: log/event order, latest at top/bottom
• Updating/Frozen presentation modes
• Easy navigation through scrolling, go to date, time filters, and so on.
• Extensive filtering that can be stored and easily called up later
• Find
• Sorting by column
• Copy/Paste of events to other applications
• Printouts
• Commenting of events

An event is a wide term that also comprises alarms. The event activation and consequential actions are defined in the process database separately for each individual object.

Typical examples on events are:
• Changes in or updating of an object value
• Changes of an alarm and a warning state
• Changes of reliability stamp
• Changes of the alarm definition, alarm blocking, acknowledgement, and so on.

When an event occurs in the system, the operator wants to receive an answer to the following questions (answers provided below each question):

1. What happened?
   • A change in the state of the object or an executed operation.

2. Where did it happen?
   • A descriptive text (object identification, OI and object text, OX) comprising for example a device notation and the type of object or operation.

3. When did it happen?
   • The point of time when the event occurred. If the event originates from a station providing a time stamp, this time stamp will be used. Depending on the station, the time is on a second or a millisecond level. In other cases, the time stamp is the MicroSCADA system time with an accuracy of 10 milliseconds.

The following functions can be activated by an event:

• Updating monitor pictures or displays
• Automatic printout. Like alarms, events can cause automatic printouts on the event and alarm printer
• Registration is made in the history buffer and, in connection to this, also in the Event List
• Activation in the report database, for example automatic control operations, registration, report printout, and so on.

Depending on how crucial an object is, the following events in the object may activate an event printout, a registration in the history buffer, or an activity in the report database (from the least to the most crucial object):

• No activation
• An alarm is activated and deactivated
• The alarm or warning state changes
• The object value changes
• The object value is updated, although it is not changed

5.1. Starting Event List

There are two ways to access the Event List. Either selecting Reports > Event List or by clicking Event List on the toolbar.

![Figure 5.1.1 Starting Event List from the application window](A050228)

In order to make the handling of the Event List more efficient and convenient, the Event List provides a set of functional settings. These functional settings are found from the Event List menu of the application window. The Event List provides also a toolbar as an alternative for the Event List commands. The toolbar does not contain all the functions that can be found in the Event List menu. The toolbar should be considered as a shortcut to the most used functions. In the application window, the Event List toolbar can be enabled or disabled by using the Customization dialog by selecting Tools > Customize.

The Event List menu contains the following commands:

- **Filters**: Opens a dialog, where filters can be selected and edited.
- **Settings**: Opens a Settings dialog, where the common Event List settings can be changed.
- **Layout Settings**: Opens a Layout dialog, where column contents in the Event List can be changed.
- **Color Settings**: Opens an Event Color dialog, where event text colors and conditions can be changed.
- **Print**: Opens a Print dialog, which is used for printing the Event List.
- **Find**: Opens a Find dialog, which is used for searching the specified text string in the Event List.
- **Updating mode**: Sets the Event List to the updating mode.
- **Frozen mode**: Sets the Event List to the frozen mode.
- **Go To**: Opens a submenu, where the user can go to:
  - Previous event set
  - Specific day
  - Next event set
  - Last event
- **Show Info Fields**: Displays/hides the info fields.
Show List Headers: Displays/hides the list headers.

Copy to Clipboard: Copies selected events to clipboard.

Help: Opens the Help Dialog.

The toolbar is a shortcut that can be used in parallel with the drop-down menu.

The buttons in the toolbar from left to right are:

- Filters
- Find
- Change presentation (Updating or Frozen)
- Settings
- Print Event List
- Go to previous event set
- Go to selected day
- Go to next event set
- Go to last event
- Show help
- Configure the toolbar

You can add or remove buttons on the toolbar the same way as in applications in general, refer to Section 2.4.3. Changing application layout.

5.2. Configuring user interface

The information presented on the screen consists of several elements, which will be described in the following section. The Event List is designed to be easy to understand and easy to use; the layout is clear and consistent. There are four types of navigation objects in the Event List: a scroll box, scroll arrows, Event List menu and Event List toolbar buttons.
The following list describes the explanations to Fig. 5.2.-1:

1. Toolbar (can be shown/not shown)
2. Event List menu
3. Date and time for the beginning of the event set
4. Date and time for the end of the event set
5. Actual page and the total amount of pages in the event set
6. Line with event specific data
7. Object status symbol
8. Indication that the event has also caused an alarm
9. Comment marker, indicating that there are additional remarks for the event
10. Settings information, the used filters
11. Settings information, frozen or updating mode for the Event List
12. Settings information, scroll order: LOG or EVENT, indicates if events are ordered according to the logging time or time stamp.
13. Scroll arrow for the events, downwards
14. Scroll box for scrolling the events
15. Scroll arrow for the events, upwards
16. List view column headers (can be shown/not shown)
17. Upper info fields (items 3, 4 and 5). These fields can be shown/not shown.
18. Lower info fields (items 10, 11 and 12). These fields can be shown/not shown.

**Event rows**

The default event line (see Fig. 5.2.-1) that describes the event consists:

- Status sign
- Time stamp
- Object identification
- Signal name
- Status text

The status text is connected to the object value. Furthermore, the status text is event or customer specific. The most important task that the event text has is to provide the operator with information about the event.

The Event List supports a standard layout, which is designed to meet the demands of the normal event display. Sequential printouts are also done according to the same standard layout.

The typical event line in the Event List contains columns that presents the information on the event. The first three symbol columns (alarm, object status and comment) have the length of one character. Each column presents the status for the object in question with a symbol character. The fourth and fifth columns present the time stamp of the event. The sixth column presents the Object Identifier (OI) and the seventh column the Object Text (OX). The eight column presents the Status Text (SX).

The default event text always gives an answer to the questions What?, When? and Where? Thus, the event texts contain these basic data both on the screen and on the sequential event printouts. The event text will be the same in the Event List and on the sequential event printers. Filters that are used in the Event List presentation do not limit the normal printouts to the printer. The default event text will always fit on the display and on the paper printouts.

**Alarm symbol**

The alarm symbol is the first column shown in the beginning of the event line. If the object is alarming, the symbol * is displayed. See the number eight (8) in Fig. 5.2.-1.

**Object status symbol**

The object status symbol is the second column shown in the beginning of the event text line. See the number seven (7) in Fig. 5.2.-1. If the object is alarming or the object status differs from normal, the status symbol is displayed as follows:

**Table 5.2.-1 Object status symbols**

<table>
<thead>
<tr>
<th>Status</th>
<th>Color</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Faulty value</td>
<td>Magenta</td>
<td>F</td>
</tr>
<tr>
<td>Obsolete value</td>
<td>Red</td>
<td>&lt;</td>
</tr>
<tr>
<td>Faulty time</td>
<td>Red</td>
<td>T</td>
</tr>
<tr>
<td>Not sampled</td>
<td>Magenta</td>
<td>?</td>
</tr>
</tbody>
</table>
Object comment symbol

The object comment symbol is the third column shown in the beginning of the event line. When a comment is added, the exclamation point (!) is displayed. See the number nine (9) in Fig. 5.2.-1.

5.2.1. Configuring layout settings

The layout settings can be configured by selecting Event List > Layout Settings. The list on the left contains all available attributes in the system and list on the right contains the attributes that are selected to be viewed in the Event List. The captions of the attributes and their positions in the Event List can also be modified.

Fig. 5.2.1.-1 Layout settings

In the Attributes box are shown all the available attributes. In the Selected Columns are a list of selected columns. You can add attributes to Selected Columns list by clicking >. Clicking >> adds all the attributes to Selected Columns list.

You can removes selected attributes from the Selected Columns list by clicking < or remove all attributes from Selected Columns list by clicking <<.

You can move a selected column upwards by clicking Up or downwards by clicking Down.

Default Settings sets the default column settings. OK applies all the pending changes and closes the dialog window. Apply applies all the pending changes but leaves the dialog window open. Cancel discards all the pending changes and closes the dialog window but does not cancel or undo changes that have already been applied. Help opens the help window.

5.2.2. Changing event line layout

For the information on how to change the layout, refer to Section 5.2.1. Configuring layout settings and Section 5.2. Configuring user interface.
In some applications there is a need to change or to extend the event text. When extending the event text, there may be some limitations that need to be taken into account. In some cases, one limitation can be the width of the matrix printer that is used as the event printer. The printing width is normally 80 characters and it is impossible to print more information. Then the alternative is to leave out some of the basic information.

The event text layout can be configured according to the different needs of different applications or countries. You can configure the event display to view information other than the default. The event text can be changed back to the default any time by using the Layout dialog. The additional information is displayed as columns on the same line as the basic information. The event text layout can be configured to allow more information displayed on the screen than what is listed to the event printer.

The status text displays the object status (Open, Close, Warning, Alarm, and so on.). Additional data is determined by the event. Additional data can be any attribute that is stored in the history buffer and the HDB. You can configure the event specific part and the Event List header. If the additional data is the same for all events, it can be written as a label text, which is common to all columns.

The common part of the event text contains data that you want to display on all the event views. The configuration of the common part can be changed in the Layout Settings dialog of the Event List. The event specific data can be configured in the Layout Settings dialog of the Event List. The event specific data consists of two parts: the status text and additional data.

### 5.2.3. Changing event texts

Events stored in the history database cannot be changed. When events are stored in the history database, the text identifiers are used instead of event texts. At run-time, the contents of the event text identifier is evaluated. The result is localized event text, which depends on the language of the monitor or application at that time. The texts and identifiers can be edited by using the following tools:

- Text Translation tool
- Object Navigator

Changes made to the texts affect all the concerned events that are displayed in the Event List. For further information, refer to the SYS 600 *9.1 Application Design manual.

### 5.2.4. Viewing and listing events

The events can be viewed on the display by using the Event List. The default display format of the Event List is similar to the format of the sequential printouts.

You can define different filters to display specific events or additional information about the events. The Event List can contain more information than the sequential printout. The sequential printouts to the event printer are sent to the event printer by the Base system instantly after the event has occurred in the application. The filters do not affect the sequential printouts.
5.2.5. Scrolling events

The event archive may contain events stored during several years, which means that the number of events can be very big. The Event List does not load all the events from the archive but it shows one event set at a time. An event set is a certain amount of events limited to a specific time window (number of days) or to a specific number of event pages, whichever limit is reached first. The event set can be configured in the Settings dialog.

The time frame of the event set is shown in the upper info field of the list.

Scrolling the Event List always stops the automatic update of the list when new events occur. The mode can always be changed back to updating by selecting Updating mode in the toolbar or menu bar and this action always brings up the last event set.

The following scrolling methods are supported.

1. Scrolling within the event set
   - The Event List supports scrolling within an event set, by means of the scroll bar or by means of the keyboard (Arrow keys, Page Up, Page Down).

2. Scrolling between the event sets
   - It is also possible to scroll to the previous or next event set. Scrolling between the event sets is done with the toolbar buttons or from the menu bar (Go to previous event set, Go to next event set).

3. Go to a specific day
   - It is also possible to call up a specific day by selecting Go to selected day button in the toolbar or menubar. Selecting this option brings up a new event set that starts from the selected day.

4. Go to the last event
   - It is always possible to go to the last event by selecting Go to Last Event button in the toolbar or menu bar.

5.2.6. Sorting columns

By clicking on a column header in the Event List, the Event List is sorted according to the column. If the same column is clicked twice, the sorting is descending.

After the data is sorted, the list is set to Frozen mode. Column sort is reset when the list mode is changed back to Update.

5.2.7. Finding events

You can search text within the current Event List view by selecting Event List > Find.
Finding events

The Find dialog box searches the list from the start to the end. If an event line contains the desired text, it is selected.

A message appears when the end point of the search has been reached or when the searched text is not found.

5.2.8. Printing

All events of the event set can be printed by selecting **Print Event List** in the toolbar or by selecting **Print** in the **Event List** menu.

5.3. Handling events

Event handling is divided into two main groups:

- Event registration
- Event viewing

The event presentation is divided into subgroups, such as:

- Viewing events on display (Event List)
- Sequential listing to the printer

Events are the activities that are registered by the MicroSCADA base system in the history database (HDB). There are two types of events: process events and internal events. The process events are events that belong to the supervised process such as indications, protecting events, alarm limits for measurements, tripped breakers, and so on. The internal events are events which indicate disturbances in the supervision system. They are normally initialized by the system.

When an event occurs in the system, it is instantly printed on the event printer and stored in the history archive. The history archive is used when the Event List is produced on the screen. The archive contains all dynamic information related to the event. All dynamic data from the history archive can be used to define filters. The history archive consists of the computers RAM and of the HDB files stored on the PC hard disk. The history database consists of the history database files, of which each contains events of one day. The files are named according to the date as APL_yymmdd.PHD. For example, the file APL_040630.phd contains the events logged on 30-Jun.-2004. The files are stored in the directory /SC/APL/nnn/APL_, where nnn is the name of the application.

The event handling is based on the information in the HDB. In other words, the information displayed in the Event List comes from the HDB. When the Event List is displayed on the screen, files in the HDB on the hard disk are read and the content is organized into a chronological order. After the content has been organized, the events are displayed on the screen. The texts related to events are read from the text.
database. The default language is English. Both the texts and the file names are translated into local languages by the project engineer during the engineering. The Text Translation tool is used for the translation.

5.3.1. Configuring Event List settings

To configure Event List settings (see Fig. 5.3.1.-1), the authorization level Control is required. The Settings dialog is used when customizing the list. It is possible to change a large number of parameters on the list.

![Settings dialog](event_list_settings.tif)

To configure the Event List you can specify the following settings:

- In the Max. nr of days/event set drop-down list you can set the maximum number of days that will be included in one event set.
- In the Max nr. of pages/event set drop-down list you can set the maximum number of pages that will be included in one event set.
- In the Scroll order drop-down list you can define the sorting order of the events in the frozen mode.
- In the Timeout drop-down list you can specify the maximum amount of time for the history database query.
- Selecting the Day break option you can define if a light blue background will be presented between the events that have time stamps from different days.
- Selecting the Latest event on bottom option you can specify the location of the latest event on the list.
- Under the Font Settings you can define the font style and size.
- Font Name Defines the font name for the events.
- Default settings load the default settings.
- Font Size Defines the font size for the events.

**OK** applies all the pending changes and closes the dialog window. **Apply** applies all the pending changes but leaves the dialog window open. **Cancel** discards all the pending changes and closes the dialog window but does not cancel or undo changes that have already been applied. **Help** opens the help window.
When the Event List is in the updating mode, the events are sorted in the order which they were written into the history database, that is, logging order. The order defined in the Settings dialog is applied in the frozen mode. The following settings can be selected in the Scroll Order list:

- LOG: Events are sorted in logging order in the frozen mode.
- EVENT: Events are sorted in event time order in the frozen mode.

5.3.2. Registrating events

All the activities in the supervised processes that are logged by the Base system are stored in the process database. The process database handles all registration of the incoming and outgoing process data. The process database is located in the application; it is project specific but the main functions remain the same, regardless of the application.

The events that are logged by the Base system and the database are stored on a mass storage (the hard disk). In other words, the Base system creates files on the hard disk where the events are stored. Every time when an event occurs in the system, the program writes a new item in the HDB. The item in the HDB is a part of the situation for the object in question when the event occurred. All dynamic data from the actual process point is stored in the HDB.

5.3.3. Adding comments

Comments can be used for making remarks to events. The comments are available to all Event List users and they can give additional information. Comments can also be removed.

You can open the Comments dialog by right-clicking on an event line with or without the comment marker and selecting Comment in the shortcut menu. Events with comment markers are shown in Fig. 5.3.3.-1.

![Comment dialog](image)

Fig. 5.3.3.-1 Comments dialog

To add a comment:

1. Open the Comments dialog as described earlier.
2. Write the comment to the dialog and click **OK**. Comment lines are preserved as typed.
3. Press Enter after each line. If no comment text is given, no comment mark will be displayed in the Event List.

Open the Comment dialog to read the comment. To remove the comment, click **Remove Comment**.

The comment text is saved as TEXT data type in the EX attribute of the event with a length of 255 characters separated ASCII 10 (new_line). Event data is saved in the History Database (HDB).

### 5.3.4. Reading events from HDB files

All the events that are inside the history time limit (defined in the Settings dialog), are read into the list until the history length limit is reached. When the history length limit has been exceeded, the reading of the events is stopped and the Previous interval button is activated. If the interval is full when new events occur, the oldest event of the interval will be moved to the previous interval.

### 5.3.5. Locating object

By clicking the right mouse button on a selected event line, a shortcut menu opens. In this menu, you can select Locate Object. The function of this option is to show the process point according to the logical node and the index (LN and IX) attributes.

### 5.3.6. Copying events

You can copy selected events from the list to the Windows' clipboard in text format. In the copy, the columns are separated with tab stops.

Before events are copied to the clipboard, the old data is erased.

### 5.3.7. User authorization

The default authorization group for the event handling are:

- Engineering (2): Editing Substation and Bay filters in the Filters dialog
- Control (1): Selecting existing filters in the Filters dialog
- View (0): All other operations

### 5.3.8. Updating Event List

If the Event List is in the updating mode, the list will be updated when a new event occurs in the system. When the list is in the frozen mode (non-updating), a message will be displayed informing you to proceed to the last events and to change the mode to the updating mode.

The Event List update is not automatic when:

- You have scrolled the list and the focus is not on the latest events
- You have selected the frozen mode
- The time filters are active

In the cases mentioned above, the Event List displays a message about the new events in the system. After this the you can proceed to the Last Events. If the time filters are on, you will be asked to reset the filters before changing to the updating mode.
5.4. Using filters

Filters are used when you are displaying or concentrating on specific information. Filters are activated from a subdialog on the list. Filters are defined by selecting Event List > Filters from the menu bar. The Filter dialog contains standard filters that can be selected by the user. The Filter dialog provides at least the following standard filters: all events, event time, per substation, per bay and per device.

It is possible to change the existing filters or to add new filters that can be stored and reused by other operators. The Filter dialog contains a specification form where the you can create new filters or change the existing filters.

For more information about setting filters, refer to Chapter 6. Alarm List and the SYS 600 *9.1 Application Design manual. The setting principles and functions are common to the Event and Alarm Lists, and therefore, they are described only once.

5.4.1. Configuring color settings

It is possible to configure certain events to use different colors in the Event List. This improves the possibility to locate certain system events. For example, important events, which cause alarms in the system, can be defined to use the red color in the Event List. For more information about configuring the event conditions, refer to SYS 600 *9.1 Application Design manual.

To use Event Color Settings, the authorization level Control is required. The Event Color Settings dialog is used when the Event List is customized with different colors for events in the list view. The coloring of events is defined with the one or multiple conditions defined in the Event Color Settings dialog, see Fig. 5.4.1.-1.

![Event Color Settings dialog](image)

To add a new line to the list, click Add. Remove the selected line from the list by clicking Remove.
OK applies all the pending changes and closes the dialog window. Apply applies all the pending changes but leaves the dialog window open. Cancel discards all the pending changes and closes the dialog window but does not cancel or undo changes that have already been applied. Help opens the help window.

The available operators for the conditions are described in Table 5.4.1-1.

Table 5.4.1-1  Condition operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Equal than</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less than</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less or equal than</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater or equal than</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Not equal to</td>
</tr>
</tbody>
</table>

The Value field contains the value that is compared to the selected attribute by using the selected comparison operator. It is possible to use the wildcard character * when defining the value of the Value field but then the only allowed operators are = and <>. For example, a value 5* means that the first character in the value must be 5 but the rest of the value can contain any number of arbitrary characters.
6. Alarm List

The Alarm List displays a summary of the present alarm situation of the supervised process. Each alarm is normally presented as an alarm text line, which describes the cause of the alarm in the process. The alarm text line normally has a time stamp, an object id, an object text, a text indicating the alarm status, as well as a number ranging from 1-7 indicating the alarm class. See Fig. 6.-1 for Alarm List Template 1 and Fig. 6.-2 for Alarm List Template 2.

Information on configuration is provided in the SYS 600 *9.1 Application Design manual.

Fig. 6.-1 Alarm List Template 1
The Alarm List contains the following features and options:

- Two types of Alarm List templates
- User-friendly filters
- Alarm List setting tool for colors and text layout
- Updating/Frozen presentation modes
- Alarm acknowledgement
- Alarm reset function
- Authorization support
- Help in all dialogs
- Visible Alarm Class
- Locate Object
- Column sort
- Find

Template 1 and Template 2 have also other features than those described above. These templates include:

- Fields indicating the number of active and unacknowledged alarms
- A field indicating the use of filters
- A field indicating the current presentation mode
6.1. Starting Alarm List

This section describes the alarm handling mechanism of the process database, the functionality of the Alarm List and the way in which the alarms are presented on the list.

The Alarm List is started by selecting **Reports > Alarm List**. By default, the two templates are included the Alarm List (see Fig. 6.1.-1).

![Starting the Alarm List from the application window](image)

When the filters are defined, only those alarms that belong to the filter configuration are displayed. When the filter is defined, the used text filters are displayed on the status bar of the Alarm List. By default, the filters are not used.

An alarm is activated in the following situations:

- An incoming binary signal (BI type process object) changes to an alarming state.
- A double indication (DB type process object) changes to an alarming state, for example a breaker mid state due to a faulty operation.
- An analog measured value (AI type process object) exceeds the alarm limits (the preset upper and lower limits).
- An object is marked faulty by a process device.
- A system error or communication failure occurs.

If the process object has an alarm function and the alarm is not blocked, information on the alarming process object (predefined set of attribute values) will be transferred to the alarm buffer. An alarm remains in the alarm buffer until the object returns to a non-alarming state and the alarm has been acknowledged, provided that the object requires an acknowledgement. Process alarms and internal alarms are handled in the same way, provided that the System Self Supervision function is in use.

To make alarm handling more effective and convenient, the Alarm List templates provide a set of functions. Those functions are collected to the **Alarm List Template 1** and **Alarm List Template 2** menus.

The **Alarm List Template 1** and **2** menus contains the following commands:

- **Filters**: Opens a dialog, where filters can be selected and edited
- **Settings**: Opens a Settings dialog, where the common Alarm List settings can be changed.
- **Layout Settings**: Opens a Layout dialog, where the column contents of the Alarm List can be changed.
- **Print**: Opens a Print dialog, which is used for printing the Alarm List.
Find: Opens a Find dialog, which is used for searching the specified text string in the Alarm List.

Updating mode: Sets the Alarm List to the updating mode.

Frozen mode: Sets the Alarm List to the frozen mode.

Go To Last Alarm: Scrolls the list to show the latest alarm and sets the mode to updating.

Acknowledge:
• All: Acknowledges all the alarms on the list. A confirmation dialog is opened to confirm the operation.
• Page: Acknowledges all the alarms on the current pages (both lists). A confirmation dialog is opened to confirm the operation.

Show Info Fields: Displays/hides the info fields

Show List Headers: Displays/hides the list headers.

Copy to Clipboard: Copies the selected events to clipboard.

Help: Opens the Help Dialog.

The following facts about the tools should be noted:

Whenever a dialog is opened, all the main toolbar buttons and scroll bars are not available (they will be available again when the dialog is closed).

The presentation mode is set to frozen while the Acknowledge command is being used.

The toolbars make your work more efficient. They provide a shortcut to the commands in the menus. The toolbars in the Alarm List Template 1 and Alarm List Template 2 can be modified separately. By default, the toolbars show the same commands.

Fig. 6.1.-2 Toolbar of Alarm List

The buttons in the toolbar of Alarm List are from left to right:
• Filters
• Find
• Change presentation (Updating or Frozen mode)
• Settings
• Print
• Latest Alarm
• Acknowledge All
• Acknowledge Page
• Help

You can add or remove buttons on the toolbar the same way as in applications in general, refer to Section 2.4.3. Changing application layout.

6.2. Configuring user interface

The Alarm List has two templates: Template 1 and Template 2. You should select one of these templates to be used as the Alarm List, although the templates have been designed to enable parallel use. The templates share some of the dialogs while others are template specific.

In Template 1, alarms are presented on two separate lists: the upper list contains active acknowledged and unacknowledged alarms (persisting alarms), while the lower list contains inactive unacknowledged alarms (fleeting alarms). All the alarms contained in the alarm buffer are presented. Both lists are scrollable. Fig. 6.2.-1 presents the Alarm List Template 1.

![Alarm List Template 1](image)

Fig. 6.2.-1 The Alarm List Template 1
Alarm rows

In Template 1 each alarm is presented as a single alarm text line. This text line has a time stamp (date and time), an object ID, an object text, a status text and alarm class. As stated before, the width and the position of each column can be defined within limits. The color of each alarm type can be selected from a predefined set of nine colors.

Table 6.2.-1 Default colors and status texts of the presented alarm types

<table>
<thead>
<tr>
<th>Alarm type</th>
<th>Default color</th>
<th>Status text</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active unacknowledged a</td>
<td>Red</td>
<td>Alarm</td>
<td>An alarm has been reported, but it has not been acknowledged</td>
</tr>
<tr>
<td></td>
<td></td>
<td>High alarm b</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Low alarm b</td>
<td></td>
</tr>
<tr>
<td>Active acknowledged a</td>
<td>White</td>
<td>Ack.</td>
<td>An alarm has been reported, and it has been acknowledged</td>
</tr>
<tr>
<td></td>
<td></td>
<td>High alarm Ack. b</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Low alarm Ack. b</td>
<td></td>
</tr>
<tr>
<td>Inactive unacknowledged c</td>
<td>Green</td>
<td>Normal</td>
<td>The state has been alarming, but it is no longer alarming</td>
</tr>
</tbody>
</table>

a. included in persisting alarms
b. shown with analog values
c. included in fleeting alarms

Template 2 in the Alarm List has another approach to the function and layout of the Alarm List. When the Alarm List Template 2 is open, the inactive acknowledged alarms are also kept on the list, unless dropped out by using filters. Due to this, Template 2 functions as a sort of alarm log. The inactive acknowledged alarms are not included in the alarm buffer, and therefore, these types of alarms are erased from the list when the Alarm List is closed. The same can be done by selecting Alarm List Template 2 > Reset from the menu.

Additionally, the way of presenting alarms on the list has been renewed. There are two main changes. Firstly, all alarms are displayed on a single list. Secondly, a flashing character * indicates all unacknowledged alarms, both active and inactive. Template 2 is presented in Fig. 6.2.-2.
6.2.1. Configuring Alarm List layout

The Alarm List layout is configurable, in such a way that operators can receive the information in the form they want. The following issues in the Alarm List are user-defined and included in the Alarm List settings:

- The width of columns
- The position of columns
- The color in which each type of alarm is presented (a predefined set of colors)
- The order in which the alarms are presented (the latest alarm on the top or at the bottom of the Alarm List)

These settings can be saved in an application specific parameter file. Default settings can be restored. The length of the object identification column is defined in the application settings picture.

Alarm List can be configured to display different alarm types using different colors. The different alarm types are listed in the Table 6.2.1-1. Each of these alarm types may be configured to display one of the following colors: Brown, Yellow, White, Blue, Black, Red, Magenta or Green.
In the Alarm List Template 1, it is not possible to define the color for Inactive acknowledged alarms.

6.2.2. Sorting columns

By clicking the left mouse button on a list column header, the Event List is sorted. The column that is used for sorting is the column that was clicked. If the same column is clicked twice, the sorting is descending.

After the data is sorted, the list is set to the Frozen mode. The column sort is reset when the list mode is changed back to Update mode.

6.2.3. Finding alarms

The Find function allows you to search for text within the current Alarm List view (see Fig. 6.2.3.-1).

Find searches through the list from the beginning. The alarm line that contains searched text is set selected.

A message is displayed when the search is ended or the searched text does not exist.

6.3. Handling alarms

The process database is the part of the base system where all the registration of incoming and outgoing process data takes place. The process database also supervises the current alarm situation of the various process objects by storing information of process objects with an alarm generating state into a special alarm
buffer. The interface for the alarm handling is the application process database, which is project specific, but the main functionality of the process database is always the same.

**Process alarms**

Process alarms are alarms that are related to the supervised process, for example, measurement values exceeding or going below the preset alarm limits, breakers tripping or getting into a faulty position and so on.

**Internal alarms**

Internal alarms are alarms caused by the network control system itself. Reasons for these alarms contain communication problems between a communication unit and substation, printer device errors, substation getting suspended, and so on. These kinds of erroneous states are detected and converted from internal system messages to alarms by the System Self Supervision function of SYS 600.

**System alarm**

A system alarm is an alarm generated by an external module supervising the Base System. The external module is working as a Watch Dog for the base system and it generates an external alarm if the base system stops. It is not possible to include this alarm in the Alarm List.

**Alarm acknowledgement**

An acknowledgement of an alarm is a way to show that the operator has registered and identified the alarm. Generally, acknowledging an alarm does not affect the alarm state. An unacknowledged alarm remains in the alarm buffer until it is acknowledged, even if the alarm state has passed. A required acknowledgement can be set individually for each process object (RC attribute).

**Alarm blocking**

Alarm blocking blocks a signal in such a way that it cannot generate an alarm. (The same implies to history blocking, printout blocking and action blocking). Since the alarm is blocked, it is not registered in the process database when the process object gets into an alarm generating state. The other types of blocking are history blocking, printout blocking and action blocking.

It is not possible to block a feature that has not been activated, for example, alarm, history, printout and action features. Alarm blocking is set individually for each process object (AB attribute).

**Alarm classes**

The term alarm class means that the alarms can be grouped into seven equally significant alarm classes. This feature can be used when you want to group alarms caused by process objects with common properties, for example object location. From the base system point of view, there is no internal priority between the different alarm classes. The alarm classes can also be used when searching alarms from the alarm buffer. By setting the alarm class to 0, the alarm function of a process object is set off. The use of the alarm classes is user-defined.
Function and alarm class lists differ from the object lists since they are not editable and they are not saved into a file. This is to simplify modifications. The number of the selected alarm class refers directly to the alarm class of the alarms to be shown in the Alarm List. Any combination between these two lists is possible.

6.3.1. Configuring Alarm List settings

The ability to change the layout of the Alarm List is based simply on the use of variables such as the alarm type color numbers and string lengths. These settings are saved into an application specific text file in user specific directory and are also read from there. Therefore, the settings, which were once selected, will not be lost.

Settings dialog contains also a mechanism to restore the default settings to the dialog and to the Alarm List. Restoring function ensures that the original settings can be restored whenever needed. This function can be utilized in cases when the settings made incorrect or need restoration. Note that no settings are stored to the user specific files automatically, to save them click OK.

![Settings dialog](image)

**Fig. 6.3.1.-1 Settings dialog**

OK closes the dialog and accepts the specified settings. Cancel discards all the changes and closes the dialog. Default Settings restores the default settings of Alarm List. Help opens the Help dialog.

The two Alarm List Templates have settings dialogs of their own but since the difference is limited to the amount of alarm types, both of the dialogs can be described at the same time.

When the dialog is opened (see Fig. 6.3.1.-1), active settings are shown. The Settings dialog has two main parts, Settings and Color Settings. There is a pair of options which can be used to determine the drawing order of the Alarm List, that is, whether the latest alarm will be shown on the top or at the bottom of the list. The Color Settings part includes color palettes for each alarm type.
Since the inactive acknowledged alarms are not included in Template 1, its Setting
dialog has only three color palettes while Template 2 has four. With these palettes
you can select a drawing color for each alarm type. Fig. 6.-2 shows an example of
the colors.

The Alarm Order specifies whether the latest alarm is presented in the Alarm List on
the top or at bottom of the list. By default, the latest alarm is on the top. The alarms
types are presented in different colors, the colors are introduced in Section 6.2.1.
Configuring Alarm List layout.

Saving and reading settings

Clicking **OK** in the Settings dialog saves the settings in an application specific text
file in a user specific directory. They are also loaded from the same file and
directory. If the file does not exist, the settings are loaded from the global directory.
The settings tool also has a mechanism to return the default settings to the dialog and
to the Alarm List. This feature is implemented to ensure that the original values can
be returned whenever needed. This function can be utilized in cases the settings do
not work properly or they need restoration. Please note that no settings are saved in
the default settings files. The **Cancel** and **Help** buttons function as in the filters main
dialog.

### 6.3.2. Alarm List presentation modes

The alarm buffer is updated every time the alarm state of a process object changes.
Basically, the Alarm List should be updated at each update of the alarm buffer to
give correct and up-to-date information. However, if the list is updated frequently,
it is almost impossible to concentrate on a single alarm line.

This is the reason why the Alarm List has two presentation modes: frozen and
updating. When the list is in the frozen mode, it is not updated, and the alarm
information can be read easily. If the alarm buffer is updated while the Alarm List
is in the frozen mode, the operator is notified with an informative text on the status
bar. When in the updating mode, the Alarm List is updated at every update of the
alarm buffer. The frozen mode is automatically selected, when the list is scrolled or
when a tool affecting the alarm buffer is used. The current mode is always indicated.

### 6.3.3. Locating objects

Click the right button in a selected alarm line to open a shortcut menu where you can
select **Locate Object**. The function of this option is to show the process point
according to logical node and index (LN and IX attributes). For more information
on locating logical node and index, refer to DMS 600 *4.1 Operation Manual.

### 6.3.4. Copying alarms

You can copy the selected alarms from the lists and copy them to Windows’
clipboard as text format. Columns are separated with a tabulator.

Before alarms are copied to the clipboard, old data is erased.
6.3.5. **Acknowledging alarms**

Acknowledgement of a single alarm is done by selecting the alarm text line of the desired alarm on the list. If the selected alarm is unacknowledged, the Acknowledgement dialog in Fig. 6.3.5.-1 can be opened by selecting **Acknowledge** from the shortcut menu. At the same time the Alarm List is set to the frozen mode to prevent unwanted scrolling.

![Acknowledgement dialog](fig.png)

**Fig. 6.3.5.-1 Acknowledge alarm dialog**

In the dialog, the alarm text line (except for the status text) is shown to ensure that the right alarm is acknowledged. If **Yes** is clicked, the alarm will be acknowledged, the dialog closed, and the Alarm List will be set to the updating mode and also updated. Clicking **No** closes the dialog and returns the Alarm List mode that was valid when the dialog was opened. All alarms on the list can be acknowledged at the same time by selecting Alarm List **Template > Acknowledge > All** from the menu or by clicking the appropriate button on the toolbar. The alarms currently visible on the list can be acknowledged by selecting Alarm List **Template > Acknowledge > Page** or by clicking the appropriate button on the toolbar.

6.3.6. **Alarm text indication**

The alarm text itself has the same components and is shown in the same way as in Template 1. Only the number of alarm types and the indication of acknowledgement is different. The Table 6.3.6-1 shows the alarm text colors, status texts and the state on acknowledgement indication of each alarm type. The acknowledging of alarms in Alarm List Template 2 is similar to that in Template 1.

**Table 6.3.6-1 Alarm indications**

<table>
<thead>
<tr>
<th>Alarm type</th>
<th>Default color</th>
<th>Status text</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active unacknowledged</td>
<td>Red</td>
<td>Alarm, High alarm&lt;sup&gt;a&lt;/sup&gt;, Low alarm&lt;sup&gt;a&lt;/sup&gt;</td>
<td>Flashing</td>
</tr>
<tr>
<td>Active acknowledged&lt;sup&gt;a&lt;/sup&gt;</td>
<td>Red</td>
<td>Alarm, High alarm Ack.&lt;sup&gt;a&lt;/sup&gt;, Low alarm Ack.&lt;sup&gt;a&lt;/sup&gt;</td>
<td>Off</td>
</tr>
<tr>
<td>Inactive unacknowledged</td>
<td>Green</td>
<td>Normal</td>
<td>Flashing</td>
</tr>
<tr>
<td>Inactive acknowledged</td>
<td>White</td>
<td>Normal</td>
<td>Off</td>
</tr>
</tbody>
</table>

<sup>a</sup> Shown with analog values
Table 6.3.6-2 provides an explanation for the different alarm types.

<table>
<thead>
<tr>
<th>Alarm Type</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active unacknowledged</td>
<td>An alarm has been reported, but it has not been acknowledged</td>
</tr>
<tr>
<td>Active acknowledged</td>
<td>An alarm has been reported, and it has been acknowledged</td>
</tr>
<tr>
<td>Inactive unacknowledged</td>
<td>The state has been alarming, but it is no longer alarming</td>
</tr>
<tr>
<td>Inactive acknowledged</td>
<td>The alarm has been inactivated (the state is normal again)</td>
</tr>
</tbody>
</table>

### 6.3.7. Resetting alarms

As stated before, inactive acknowledged alarms, which are not included in the alarm buffer, are collected to the Alarm List as long as the list is open. This means that the alarm information must be processed and sorted by the list itself, not by the alarm buffer like in Template 1. Thus, Template 2 is somewhat slower than Template 1, but when the amount of alarms is in reasonable proportions, this should not cause any problems.

As a matter of fact, inactive acknowledged alarms are not really alarms. The only reason to keep this type of information on the list is to show that certain process objects have been in the alarming state and in this way to collect a kind of alarm history. However, to get up-to-date alarm information, you should be able to erase inactive acknowledged alarms from the list. This can be done by selecting the Alarm List Template 2 > Reset on the menu, which returns the contents of the alarm buffer to the list. Closing the Alarm List and opening it again resets the list, too.

### 6.4. Using filters

The ability to create filters in the Alarm List is based on a SCIL feature, which allows to state conditions when making queries from the process database or from the alarm and history buffers. The following filtering criteria are typical:

- Time, upper and/or lower time limit
- Object identification (OI attribute)
- Function (breaker, disconnector, measurement and so on)
- Alarm class (can be used in grouping objects)

It is also possible to define a search condition in SCIL language.

A single criterion or multiple criteria can be used to create grid-like filters. The operator can save the filters to use them later. The substation and bay names should be produced from the actual application process database so that the filters could be modified to follow changes in the process.

If other than the default configuration is used, the information in this section must be applied accordingly. For more information on configuring the Object Identification structure, see SYS 600 *9.1 Application Design manual.
You need at least authorization level 1 or 2 to be able to use or create filters. If you have authorization level 1 rights, you can select ready made filters. If you have authorization level 1 rights, you can select and create filters. For more information on authorization levels, refer to Section 3.2. User management.

6.4.1. Defining filters

When you open the Filter dialog, active filters will be shown (see Fig. 6.4.1.-1). Items are presented in their default states. As shown in the Fig. 6.4.1.-1, object identification drop-down lists are given the label defined in SYS_BASCON.COM. If an OI field is given a zero length, the corresponding drop-down lists is set insensitive and given the label (none).

![Filter dialog](image.png)

*Fig. 6.4.1.-1 The Filter dialog*

By default, the In Use option is not set for the Lower or Upper Time Limit. When the In Use option is set, the Lower and Upper Time Limits become active. The date and time limits can be defined by using the arrow buttons or by typing the information into the appropriate boxes directly. When the date limit is defined, the date selector component is displayed on the screen.

If the option In Use has been selected for the Lower and/or the Upper Time Limits in the upper part of the Filters dialog, the limits can be set by clicking Edit and by entering the desired date and time in the dialog which appears on the screen. In case the option In Use has been selected for the Lower and/or the Upper Time Limits in the Filters dialog, the fields below are unavailable but indicate the unselected date and time.
If the Selective Filter option is set, only the items concerning the substation in the drop-down list can be selected. This means that only bays that belong to the substation, are available in the Bay drop-down list. Similarly, only devices that belong to the selected bay, can be selected in the Device drop-down list.

If the Unselective Filters option is set, the items concerning bay and device can be selected in the respective drop-down lists without limitations. It is, for example, possible to select a device without selecting a bay or a substation. As a result, all the devices with the selected name will be displayed in filtered data, regardless of the bay or station. The lower part of the Filter dialog contains the drop-down lists where it is possible to select one alarm class out of the available alarm classes. When using alarm classes, the signals that have the same functional purpose are usually included in the same alarm class.

To view the other options provided, click the More button in the Filter dialog. You can select Save Preconfiguration, Load Preconfiguration or Advanced Condition.

**Advanced condition**

To define an advanced filter condition, select the Advanced Condition from the More button menu in the Filter dialog. Then the Advanced Condition dialog is opened (see Fig. 6.4.1.-2). In this dialog, it is possible to define an advanced filter condition by using attributes found in the process database and by using a set of comparison operators and condition values. It is also possible to type in the filter condition directly in the Filter text box.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Comp.</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cond 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cond 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cond 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cond 4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cond 5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Fig. 6.4.1.-2**  **Advanced Condition dialog**

**OK** closes the dialog and accepts the specified filter. **Cancel** discards all the changes and closes the dialog. **Clear** clears the contents of the specified filter. **Help** opens the Help dialog.
Selecting objects to the filter configuration

Search filtering can be done in the Filter dialog (see Fig. 6.4.1.-1) with the help of the five combo boxes. If Selective Filter is in use, the selections become active one at a time. For example, when the Substation drop-down list is selected, the Bay drop-down list becomes active. If Unselective Filter is in use, all the drop-down lists that are configured to be used in the system, are active. Option All is selected as a default, which is indicated as a star character in the drop-down list meaning that all the signals below the level are included.

6.4.2. Saving filter setting

To save the active filter settings, select More > Save Preconfiguration in the Filter dialog. The Save As dialog is opened, where you can specify the file name and the folder for the preconfiguration file. When clicking Save, the preconfiguration file is saved. When clicking Cancel, the dialog is closed without saving.

6.4.3. Opening filter setting

To load a preconfigured filter settings, select Load Preconfiguration from the More button menu in the Filter dialog. Then the Open dialog is opened, where you can select the file name in which the preconfigured filter settings are located. Click an existing file name or select another folder in which the preconfiguration files are located. When clicking Open, the preconfiguration file is loaded and set as an active filter. Clicking Cancel closes the dialog without opening any files. To activate the filter, click OK in the main filter dialog.

6.4.4. Time filters

In the upper part of the Filter dialog, there are two options, which specify whether the Lower Time Limit or Upper Time Limit is used. If the Lower Time Limit is not in use (off), the alarms will be presented from the oldest alarm on. If the Upper Time Limit is not in use, the alarms will be presented up to the latest alarm. Only when a time limit is in use, the corresponding date and time limits can be defined. By default, when the Filter dialog is opened and you have not specified the time limits, the current time is shown. Otherwise, the specified time limits are shown in both time fields. This is possible, unless one or both of the time limits is/are in use, in which case the value in question will be set.

Clicking the More button opens the date selector, by which the time limit can be defined (see Fig. 6.4.4.-1). Whether the Lower Time Limit or Upper Time Limit is defined, the date selector opens the related time limit below indicating which time limit is edited. A certain day can be selected by clicking it, and a month can be changed by using the appropriate arrow buttons. It is also possible to define the date for the time limit by inserting a new value to the appropriate field. The time information for time limits is defined by inserting a new value to the appropriate field. OK applies the time limit values to the Alarm List and closes the dialog. Cancel discards all the changes made to time limits and closes the dialog.
6.4.5. Filter shortcuts

It is possible to configure a filter with a certain name to be loaded when the shortcut command in the menu bar is selected. The preconfigured names can be used, for example, to define a dedicated filter for each bay.
7. Blocking List

The Blocking List summarizes the present blocking situation of signals in the supervised process. Each signal is presented as a signal text line, which describes the signal in the process. The signal text line normally consists of a signal text and a group of check boxes indicating the blocking state.

Fig. 7.-1 shows the Blocking List main view.

![Blocking List main view](blocking_list_a)

**Fig. 7.-1 The Blocking List main view**

The Blocking List contains the following features and options:

- Easy signal selection
- Selection of signal(s) for blocking/deblocking
- Blocking List setting tool for the view layout
- Printout of blocking situation
- Event and printout enabling/disabling
- Authorization support
- Possibility to copy contents on the clipboard of the operating system
The process database is the part of the base system where all the registration of incoming and outgoing process data takes place. Each process device is represented in the database as a group of process objects, which provides a data image of the physical device.

On the other hand, process objects form a link between MicroSCADA and the physical device. Setting the values of the process objects carries out the control commands. The indication signals are also stored as process object values. From this point of view, process objects can be regarded as input and output signals, which will be the targets of the blocking activity.

7.1. Starting Blocking List

The blocking List can be started by selecting Reports > Blocking List (see Fig. 7.1.-1).

![Fig. 7.1.-1 Starting the Blocking List](image)

All the tools (except for the signal blocking state) can be used either by clicking the shortcut buttons in the toolbar or by selecting the corresponding items in the Blocking List menu.

![Fig. 7.1.-2 Toolbar of the Blocking List](image)

The buttons in the toolbar from left to right are:

- Selective blockings
- Find in blockings
- Print blockings
- Refresh Blocking List
- Scroll the page up
- Scroll the page down
- Go to the beginning
- Go to the end
- Help
You can add and remove items in the toolbar by clicking the arrow button in the end of the toolbar.

7.2. Configuring user interface

The Human System Interface (HSI) of the Blocking List consists of a list showing the blocked signals and their blocking states. It also shows the toolbar and a set of functions and dialogs accessed from the Blocking List menu of the Application Window. The Blocking handling is mainly done by using the Blocking List main view and of various dialogs and subdialogs (see Fig. 7.2.-1).

**Fig. 7.2.-1 The Blocking List main view**

The following list describes Fig. 7.2.-1:

1. Blocking List menu
2. Toolbar buttons
3. Check boxes indicating the blocking state of the signal
4. Current page and the total amount of pages
5. Signal text
6. Scroll box
7. Arrows for scrolling the page up or down
8. Fields presenting the sum of signals for each blocking type

A signal with required properties (at least one non-zero blocking attribute value) is presented in the Blocking List in form of a text line (see Fig. 7.2.-1). This text line consists of a signal text (5) (the OI and OX attributes of the process object) and a row of check boxes (3) indicating the blocking state of the signal. An X in the check box means that the corresponding blocking is set to the signal. In addition to the check boxes, the blocking state is also indicated by the color of the signal text line. The default colors are listed below in an ascending priority order:

- **Brown**: control blocked
- **Yellow**: alarm, event, printout or reprocessing blocked
• Magenta: update blocked

At the bottom of the picture there is a row of fields (8) indicating the number of signals within each blocking type. Note that since a signal can have more than one blocking type set on, the sum of the numbers shown in the above-mentioned fields has no meaning.

The current page and the total number of pages is shown in the page number field (4). If there are more signals than visible rows on the list, the list can be scrolled by the scroll arrows (7), by clicking below or above the scroll box (6), by dragging the scroll box, or by using the (2) arrow buttons of the toolbar or the corresponding items of the Blocking List menu (1). The Blocking List tools will be described in detail in the following two sections.

7.2.1. Configuring Blocking List settings

The settings part of the Blocking List functions consists of two main parts: view and event/printout settings. You can concentrate on one or more blocking types by excluding the other blocking types from the list with the view part of the Blocking List Settings dialog (shown in Fig. 7.2.1.-1).

Concerning the presentation of the Blocking List settings. When the dialog is opened, the check boxes indicate the current view, and the same buttons can be used to include or exclude blocking types. At least one blocking type must be included, otherwise OK will not be available.

The current view is also the master switch of all the Blocking List activities: only those blocking types within the current view are included in the blocking, deblocking and printing activities. If a blocking type is not within the current view, the corresponding check boxes in all Blocking List dialogs will be unavailable.

The two check boxes in the lower part of the dialog determine whether an event and/or a printout is enabled, and when signals are blocked or deblocked by using the Blocking List. Events and printouts are enabled/disabled regardless of the attributes (for example HE and PB) of the target signal.

Clicking OK sets the selected settings to the Blocking List and closes the dialog. Clicking Cancel only closes the dialog. Help opens the Help dialog with an appropriate help text.
7.2.2. Sorting columns

The Event List can be sorted by clicking on a list column header. The column that is used for sorting is the column that was clicked. If the same column is clicked twice, sorting is descending.

Before the data is sorted, the list data is reset (acknowledged inactive alarms are removed from the list buffer) if Template 2 is used. The column sort is disabled, when the list mode is changed back to Update.

7.2.3. Finding blockings

The Find allows you to search for text within the current Alarm List view.

Find searches through the list from the beginning. The alarm line that contains searched text is set selected.

A message is displayed when the search is ended or the searched text does not exist

7.2.4. Printing blockings

The Blocking List provides a printout option for a printed snapshot of the blocking situation. You can select this option by clicking the printer push button or by selecting Print in the Blocking List menu.

Fig. 7.2.4.-1 Example of typical printout
7.3. Handling blockings

The MicroSCADA Pro SYS 600 *9.1 provides a wide range of blocking attributes, which are included in the Blocking List. To provide a blocking handling mechanism in a more clear and rational way, the following blocking types are provided by the Blocking List:

- Alarm blocking: alarms are not raised, regardless of the object state.
- Update blocking: indications are not updated by the process.
- Control blocking: operation commands are not sent to the process.
- Event blocking: event registrations are not made, events are not shown in the Event List.
- Printout blocking: events are not sent to the printer.
- Reprocessing blocking: event channel activation is blocked.

Fig. 7.2.1.-1 shows the settings of Blocking List as an example.

As stated before, simply setting the corresponding blocking attribute value to 0 or 1 performs the blocking and deblocking of a signal. This, and the fact that there is no tag in the database indicating when an individual signal has been blocked or deblocked, means that the Blocking List cannot be a dynamic picture. Polling the blocking attributes of all the signals in the database at regular intervals would be a too heavy load for the system. A Refresh function is provided to enable updating of the blocking information.

Finally, the blocking activity must be expanded to the signal level. The reason for this is that, for example, in case of an oscillating signal, you must be able to block it but leave the other signals (related to the device in question) unblocked to minimize the information loss. Blocking is possible either by setting the blocking state of each signal presented on the list or fetching any signal from the database and set its blocking.

When a signal is update-deblocked, its state in the database is not necessarily up to date, since the state of the process device may have changed while the signal has been update-blocked. Therefore, the state of each signal must be updated from the process when the signal is update-deblocked.

The blocking List is refreshed by selecting Blocking List > Refresh or by clicking the appropriate toolbar button.

7.3.1. Setting signal blocking state

The blocking state of the signal can set by clicking the selection box of the signal in question. If there is a cross in a selection box, the signal in question will be blocked. Otherwise the signal will not be blocked. Since a signal can be either of indication or control type, the selection boxes corresponding to either one of the blocking types is unset and unavailable, depending on the signal.

Alternative way to set the blocking states of the signal is to use the copy-paste function. The selected signal's blocking states are copied by pressing CTRL-C and the blocking states can be set to another signal by pressing CTRL-V.
Note that if all the blockings are deblocked, the signal will be removed from the Blocking List. If a non-internal signal is in the update-deblocked mode and it is connected to a process, its state will be updated. See also Section 7.3.2. Defining blocking conditions concerning the blocking conditions.

### 7.3.2. Blocking attributes and blocking types

The MicroSCADA provides a wide range of blocking attributes, which are included in the Blocking List. To provide a blocking handling mechanism in a more clear and rational way, the following blocking types are provided by the Blocking List:

- Alarm blocking (AB): alarms are not raised, regardless of the object state.
- Update blocking (UB): indications are not updated by the process.
- Control blocking (CB): operation commands are not sent to the process.
- Event blocking (EB): event registrations are not made, events are not shown in the Event List.
- Printout blocking (PB): events are not sent to the printer.
- Action blocking (XB): event channel activation is blocked.

It must be noted that the abbreviations on the list above are not process object attributes, but abbreviations used in the Blocking List. To clarify the connection between the blocking types and the attribute values, they are given together in the Table 7.3.2-1.

#### Table 7.3.2-1 Blocking types and their attribute values

<table>
<thead>
<tr>
<th>Blocking type</th>
<th>Attribute values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm blocked</td>
<td>AB = 1</td>
</tr>
<tr>
<td>Update blocked</td>
<td>UB = 1</td>
</tr>
<tr>
<td>Control blocked</td>
<td></td>
</tr>
<tr>
<td>Event blocked</td>
<td>HB = 1</td>
</tr>
<tr>
<td>Printout blocked</td>
<td>PB = 1</td>
</tr>
<tr>
<td>Reprocessing blocked</td>
<td>XB = 1</td>
</tr>
</tbody>
</table>

#### Defining blocking conditions

A blocking can be made only if an alarm class has been defined for it.

The values of the process object attributes are viewed to judge whether it is reasonable to make a blocking for it or not.

The following conditions apply for blockings. These conditions have been defined for blockings in order to prevent unnecessary operations.

#### Table 7.3.2-2 Conditions that apply for blockings

<table>
<thead>
<tr>
<th>Blocking type</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm blocking</td>
<td>Alarm blocking is possible when AC = 0</td>
</tr>
<tr>
<td>Printout blocking</td>
<td>Printout can be blocked (a printer has been defined) when LD = 0</td>
</tr>
<tr>
<td>Action blocking</td>
<td>Action blocking is possible when AE = 0</td>
</tr>
<tr>
<td>Event blocking</td>
<td>Event blocking is possible when HE = 0</td>
</tr>
<tr>
<td>Update blocking</td>
<td>Update blocking is always possible for an input object.</td>
</tr>
</tbody>
</table>
7.3.3. Locating object

Right-clicking the mouse on a selected blocking line opens a shortcut menu where you can select Locate Object. The function of this option is to show the process point according to the logical node and index (LN and IX attributes).

7.3.4. Copying blockings

You can copy selected blockings from the lists and copy them to Windows' clipboard as text format. Columns are separated with tabulator.

Before blockings are copied to clipboard old data is erased.

7.4. Selective Signal Blocking

The Selective Signal Blocking tool of the Blocking List fulfils the other basic purpose of the Blocking List: the ability to fetch an individual signal or any group of signals, previously blocked or not, from the database and set the blocking state of these signals. This tool consists of three dialogs: the main dialog (Fig. 7.4.-1), the Search Signals dialog (Fig. 7.4.-2) and the Signal Blocking State dialog (Fig. 7.4.-3).

You can open the Selective Blockings dialog by selecting Blocking List > Selective Blockings or by clicking the corresponding button in the toolbar.

The Selective Signal Blocking main dialog has a similar user interface to the LIB 510 Trend Basket. The dialog has two lists: the one on the left with a title Signals contains the signals fetched from the database and the one on the right with a title Selected Signals contains the signals selected to be blocked or deblocked. On both of these lists, each signal is presented as a line block (an OI attribute and an OX attribute). Both lists are scrollable.

![Selective Blockings dialog](image)

Fig. 7.4.-1 Selective Blockings dialog
You can add all the signals from the Signals list to the Selected Signals list by clicking **All >>**. To add the selected signals from the Signals list to the Selected Signals list click **>** or **<** to remove the selected signals from the Selected Signals list. Clicking **<< All** removes all the signals from the Selected Signals list.

To search signals in the database click **Search Signals**. You can set the blocking state of the selected signals by clicking **Select Blockings**.

**OK** sets the selected blockings to the selected signals, updates the Blocking List and closes the dialog. **Cancel** closes the dialog and **Help** opens the Help dialog with an appropriate help text.

The Search Signals dialog is a tool by which the signals can be fetched from the database. Navigation is based on the OI attribute, which by default consists of the following three parts: a station name (10 characters), a bay name (15 characters) and a device name (5 characters). Up to five parts of the OI attributes are supported. When the dialog is opened, it reads the label of each of the parts from APL:BSV(15). The station, bay, device and so on. Names of the desired signal(s) can be entered into the dialog fields, but the following rules must be followed:

- The bay and device name fields can be left empty if the desired signal has no bay or device name (for example station L/R switch signal).
- An asterisk (*) can be given as a bay and/or device name to indicate a free name.

![Search Signals dialog](image)

**Fig. 7.4.-2 Search Signals dialog**

Clicking **OK** searches for the signals, sets them to the Signals list of the main dialog and closes the dialog. Clicking **Cancel** only closes the dialog. **Help** opens the Help dialog with an appropriate help text.

The blocking state of the selected signals can be set with the Select Blockings dialog. When the dialog is opened, the options are set to indicate the blocking state of the selected signals. If the Block button of a blocking type is set, it means that all the signals have been blocked. On the other hand, if the corresponding Deblock button is set, it means that none of the signals has been blocked. If only some of the signals have been blocked, both options are in non-set position. Furthermore, if all the signals represent the indication type, the control blocking buttons are unavailable. If all the signals represent the control type, the update blocking buttons are
unavailable. If blocking is not possible, the buttons are up and the text is dimmed. See also Section 7.3.2. Defining blocking conditions concerning the blocking conditions.

![Signal Blocking State dialog](sigblockstate_b)

Fig. 7.4.-3 Signal Blocking State dialog

Clicking **OK** sets the selected blockings to the main dialog and closes the dialog. Clicking **Cancel** only closes the dialog. **Help** opens the Help dialog with an appropriate help text. It must be noted that the blockings are set to the actual signals when **OK** is clicked on the main dialog. If a non-internal signal is set to be in the update-deblocked mode and it is connected to a process, its state will be updated by the process.

The Blocking List belongs to the user authorization group GENERAL. All blocking/deblocking and printing activities require at least Control (1) authorization level. All dialogs can be opened and the View can be set with the authorization level View (0).

### 7.4.1. Blocking in displays

You can use the blocking function to block the process objects on the following levels: station, bay and device. For example, blocking on the bay level means that all the process objects (except for the internal objects) within the bay in question are blocked. The process objects are in this case identified by their Object Identifier information. In this way, all the process objects within each substation, bay and device can be found in the database. Blocking is handled by a separate Blocking tab of the dialog (see Fig. 7.4.1.-1).

Internal objects are process objects that are used internally by the process objects related to the graphical symbols, for example for alarm generation. These objects have no connection to the physical process. Internal objects are identified by their contents of the Reserved Text (RX) attribute.
Fig. 7.4.1.-1   Blocking tab of Switch control dialog
8. Trends

The Trends display is one of the components included into the MicroSCADA Monitor Pro application. Trends display is used for trend analyses and for showing measured values in the form of a curve or a table.

The Trends display contains the following features:

- Graphical or tabular view modes
- Zooming mode
- Scrolling with scroll bars and panning
- Configurable axes and line properties
- Using legend
- Update interval options from 30 seconds to 10 minutes
- Calculation formulas; direct, mean, sum and difference
- Clearing trend data by the user
- Save, Open and Delete preconfigurations
- Printout option
- Update/Frozen modes
A trend is a time-related follow-up of process data. All types of process objects, for example in and out data, binary, analog and digital data can be illustrated as trends.

When the Trends display is shown, you can select the data from the Trend Basket. When the Trend Basket is closed, the selected trends are brought to the trend view.

Trend display configuration includes a set of parameters such as colors, fonts, and so on which are called trend preconfigurations. For more information on preconfigurations, refer to Section 8.2.3. Saving preconfiguration.

### 8.1. Starting Trends display

The Trends display can be started by selecting **Reports > Trends** (see Fig. 8.1.-1).

![Fig. 8.1.-1 Starting Trends](image)

The Trends display has three toolbars: common toolbar, graph view specific toolbar and tabular view specific toolbar. When you start the Trends display for the first time, you can see all the three toolbars. You can show or hide the toolbars by selecting **Tools > Customise**.

![Fig. 8.1.-2 Common toolbar](image)

The buttons in the Common toolbar from left to right are:

- Refresh Trends
- Open Preconfiguration
- Save Preconfiguration
- Trend Basket
- Show/Hide Trend Curves
- Enable Graphical View
- Enable Tabular View
- Updating/Frozen mode

![Fig. 8.1.-3 Graph view toolbar](image)
The buttons in the Graph view toolbar from left to right are:

- Trend Settings
- Reset Zoom to Normal zoom
- Select Auto-zooming mode
- Select Selection mode
- Select Panning mode
- Go to First Period
- Go to Previous Period
- Select Day Period
- Go to Next Period
- Go to Last Period

![Fig. 8.1.-4 Tabular view toolbar](image)

The buttons in the Tabular view toolbar from left to right are:

- Shift to First
- Shift to Previous
- Shift to Next
- Shift to Last
- Clear Current Trend Log

You can add or remove buttons on the toolbars the same way as described in Section 2.4.3. Changing application layout.

The commands in the toolbars can be selected also from the Trends menu. You can show and hide the hairlines displayed in the graphical mode by selecting Trends > Show Hairline.

### 8.2. Configuring user interface

The Human System Interface (HSI) of the Trends display consists of trends presented in the graphical form as full-graphic curves. The trend handling is mainly done by using the Trends display graphical view (see Fig. 8.2.-1) and of various dialogs.

The menu and toolbar change when the Trends display is running in the main window. The Trends menu is displayed in the menu and specific Trend display toolbars are shown.
**Graphical view**

Select the graphical view by selecting **Trends > Graphical View**. In the graphic view mode, trends are presented in the graphical form as full-graphic curves. The curves share the same X-axis and Y-axis.

The range of the axes changes automatically, when the trend values are added or removed. Axis and curve colors, styles and title fonts can be changed. Graphic legend and hairline can be shown or hidden.

You can zoom and pan the view with the corresponding buttons in the Graph view toolbar.

**Tabular view**

Select the tabular view by selecting **Trends > Tabular View**.

In tabular view, one trend is shown in the view at a time (see Fig. 8.2.-2). Trends can be changed by using the navigation buttons in the toolbar.
8.2. Tabular view of trends

Fig. 8.2.-2 Tabular view of trends

Trend values, registration time and status are shown on the list. Other trend parameters, for example object text, time interval, logging function and statistics, are shown on the right side. When you work in the tabular view mode, you can clear the current view by clicking the corresponding button in the toolbar.

8.2.1. Scrolling, panning and zooming in the graph mode

You can select the Auto-zooming mode to outline the area that you want to zoom in the graph. You can also scroll the zoomed graph by using the scroll bars. By selecting the Panning mode, you can drag the graph with your mouse.

8.2.2. Printing trends

You can print the trend data either in the tabular view mode or in the graphic view mode by selecting Trends > Print. The current trend registration values are printed as it is shown on the left side list of the tabular form. When printing with the graphic view mode active, the printout is exactly the same as shown in the graphic view at that moment.
### 8.2.3. Saving preconfiguration

The current trend view settings can be saved in a preconfiguration (see Fig. 8.2.3.-1). The following properties will be saved:

- Background color of the graphical form
- Colors and styles of the X- and Y-axes
- Text fonts of the axes
- Trend curve colors and styles
- Trend curve marker colors and styles
- Trend curve title fonts

You can save the settings by using the menu command or by clicking the corresponding button in the toolbar.

![Save Preconfiguration dialog](image)

**Fig. 8.2.3.-1 Save Preconfiguration dialog**

You can select the existing configuration or create a new configuration by typing a new configuration name. Existing preconfiguration is saved by clicking **Save**.

You can open the existing preconfiguration by selecting the preconfiguration and by clicking **Open**. After that the preconfiguration is loaded, and all the parameters are applied to the graphical form.

You can delete one of the existing preconfigurations by clicking **Delete** in the Save preconfiguration or Open preconfiguration dialogs.

### 8.3. Handling trends

You can define the graph properties and curve settings by selecting **Trends > Properties**. The Properties dialog is displayed.
You can change graph background, margins, legend position or the visibility of scroll bars on the Common settings tab. On the Axis properties tab you can change the X-axis and Y-axis properties. On the Curve properties tab you can change, for example, the line and marker colors, styles and the title font of the legend.

8.3.1. Adding and deleting trend objects

To add objects in the Trend Basket:
1. Start the Trends, if it has not already been started.
2. Select the Trends > Trend Basket or click the corresponding button in the toolbar. The Trend Basket dialog is displayed.
3. Select an object from the Objects box on the left.
4. Drag the object to the Trend basket box and drop it on the trend list. You can also right-click the object and select Add to trend log from the shortcut menu.

To configure the settings of the added trends by double-clicking the item or by right-clicking the mouse on the added trend and selecting Configure Settings from the shortcut menu.

To remove added trends, right-click the item on the trend list and select Remove Log or select the items and press DELETE.

Check from the Trend curves dialog that the related trend items are included into the active preconfiguration.

8.3.2. Editing values

When the tabular view mode is active, it is possible to enter a specified trend registration manually.

To enter the registration manually:
1. Right-click the specified trend registration and select Edit value from the shortcut menu. The Edit value dialog is displayed.

![Edit value dialog](image)

Fig. 8.3.2.-1 Edit value dialog

2. The text fields of this dialog show the index, registration time, status and current value of the selected registration. Type a new value into the Value box.
3. Click OK to change the new value to the trend.
To leave the value unchanged, click **Cancel**.

The Status column is changed to value 9 for the manually entered trend values.

### 8.3.3. Clearing trend data

You can erase the trend values by right-clicking an item in the Trend Basket dialog from right side trend list and selecting **Clear log data** from the shortcut menu, or clicking the corresponding button in the toolbar.

Access to this functionality requires that the operator has at least ENGINEERING level access rights. Otherwise, the appropriate functions are unavailable.

### 8.3.4. Exporting to text file

When the tabular view mode is active, it is possible to export the data to a specified text file regarding to an active trend item.

1. Select a trend item in the tabular view.
2. Select **Export** from the **Trends** menu. The Save As dialog is opened.
3. Specify the folder, file name and the type of the text file.
4. Click **Save** to export the data.

The exported text file contains a header information and the trended data.

### 8.3.5. Copying trends

In Trend display, you can copy the selected trend items from the tabular or graphical view to the clipboard of the operating system. In the graphical view, there are usually several trend items that are included in the selection to be copied. When you paste the selection to the clipboard, the data is divided into several sections, where each section has a header and contents of each selected trend item.

The data selection is done by using one of the three possible ways:

- To select the successive values, click the first row of the trended item to be selected, press SHIFT key down and click the last row of the trended item.
- To select the specific values, click the first row of the trended item to be selected, press the CTRL key down and click more specific rows of the trended items.
- To select all the values, right-click on some row and select **Select All** from the shortcut menu.

When the selection is done, select **Trends > Copy to Clipboard** or press CTRL+C. You can also use the shortcut menu command.

### 8.4. Working with Trend Basket

Open the Trend Basket dialog by selecting **Trends > Trend Basket**. The Trend Basket dialog displays the number of founded objects from the MicroSCADA system and allows the user to configure the items, which are included into specific trends.
By default, only measurement objects are shown. If you select the All Objects (not only measurements) option, the Trend Basket displays all the found objects from the MicroSCADA system.

Fig. 8.4.-1 Trend Basket dialog

The available objects are presented on the left side of the dialog. In the object tree’s lowest level you can select objects one at a time, which will be included into the selected items list.

You have two ways to add objects to the trend list:

1. The objects can be added by clicking the right mouse button on the objects view and applying the command from the shortcut window. Added objects are shown on the right side in the trend list.

2. You can also drag an object from the available object list and drop it to the right side trend list.

It is also possible to remove the selected items or all the items from the trend list.

You can expand and collapse the tree view in the Object box. To add an object to the Trend Basket, right-click it and select Add to Trend Basket from the shortcut menu.

**Trend settings**

The Trend Basket dialog allows you to configure individual trend parameters. You can open the Trend Setting dialog for the selected trend, which is in the trend list, by double-clicking an object, selecting a shortcut window command or clicking Edit button.
Fig. 8.4.-2 Trend Settings dialog

You can change the following trend properties:

- Time channel (0.5, 1, 2, 5 or 10 minutes)
- Logging function (Direct, Sum, Mean, Integral or Difference)

The trends can be cleared in order to erase all the registered data.

8.5. Using trend curves

You can show and hide the trend curves by selecting **Trends > Trend Curves**. The Show/hide Trend curves dialog displays the trended items the Trend Basket contains. These items can be included in or excluded from the selected preconfiguration by setting or clearing the check box of trend items. It is also possible to select all or clear all the items by using the appropriate commands from the shortcut window.

Fig. 8.5.-1 Show/hide trend curves dialog

By default, all the added items in the Trend Basket become automatically included and displayed in the trend curves as well. You can see the detailed information about the trended items in preconfiguration in the Show/hide Trend curves dialog.

**Properties**

Trend curve settings can be changed by using the menu command or by clicking the corresponding button in the toolbar.
The Common settings tab of the Properties dialog allows you to configure general graphical view settings (see Fig. 8.5.-2).

![Common settings tab of Properties dialog](image1)

**Fig. 8.5.-2  Common settings tab of Properties dialog**

The Axis properties tab of the Properties dialog allows you to change axes’ colors, styles and text fonts (see Fig. 8.5.-3).

![Axis properties tab of Properties dialog](image2)

**Fig. 8.5.-3  Axis properties tab of Properties dialog**
The Curve properties tab of the Properties dialog allows you to change individual curve settings (see Fig. 8.5.-4). Before changing the curve settings, the trend should be selected from the drop-down list.

![Fig. 8.5.-4 Curve properties tab of Properties dialog](image-url)
9. System Self Supervision

The SYS 600 System Self Supervision (SSS) is used with the MicroSCADA systems for supervising and monitoring the system. It provides status information of hardware and software, as well as picture functions for the supervision of system objects.

The SYS 600 System Self Supervision consists of:
• Supervision Base (SSS Backbone)
• Supervision Monitoring (SSS HSI)

The Supervision Base and the Supervision Monitoring are to be seen as independent components. The SSS Backbone functionality contains the basic functions of the System Self Supervision and it can be used in several system environments.

The Supervision Base operates without the presence of the Supervision Monitoring part. Therefore, it can be used in various system environments (SYS 600, SMS 510 and COM 500).

The Supervision Monitoring includes the HSI, which consists of the set of symbols that can be inserted to the system supervision display. The Supervision Monitoring part is attached to the Supervision Base through the process database, that is, indications for the object’s state is used as an interface between the Supervision Base and the Supervision Monitoring part. The SSS HSI provides the monitoring part of the System Self Supervision and it can be used only in the SYS 600 environment.

![Diagram of System Self Supervision](image)

Fig. 9.-1 The System concept design for the System Self Supervision

9.1. Introduction to system supervision

Supervision Base (SSS Backbone)

The main function of SSS Backbone is to provide the mechanism for routing supervision information into the MicroSCADA process database from the process devices and other supervised objects.

The Supervision Base consists of:
• Process objects which receive system messages from the MicroSCADA communication units; indicate the object’s state and generate events and alarms.
• Command procedures, event channels and time channels which perform the actual supervision routing and information interpreting (Supervision Routing Interpreter).

• A text file for language dependent signal texts in the database and for log events shown in the Supervision Log.

• Initialization files for storing the configuration data and event filtering information.

• A text file which contains the configuration data for the general parameters of the System Self Supervision.

• Text files which contain the source code for the command procedures.

• Text files related to System Configuration Manager.

• Viewer for log events (Supervision Log).

It contains:

• All the common system message points.

• Event channels for predefined events.

• Command procedures and indication points for handling system messages and events.

• Indication points for handling system messages and events.

It provides the status information of the:

• Hardware.

• System components.

• Communication equipment.

• Process control.

• Protection units.

**Supervision Monitoring (SSS HSI)**

The main function of the SSS HSI is to provide the visual monitoring part for supervision of the running system, using the system supervision display.

Supervision Monitoring provides following components:

• Monitor

• Base System

• Application

• Communication unit (NET)

• Communication unit line (NET line)

• Station

• LON Clock Master (SLCM)

• Printer
You should use the symbols found from the Palette of Display Builder for supervision monitoring, the symbols are presented in the Table 9.1.-1.

Table 9.1.-1 Possible symbols for Supervision Monitoring

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Identification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor</td>
<td>Monitor.sd</td>
</tr>
<tr>
<td>Base System</td>
<td>Angled PC.sd</td>
</tr>
<tr>
<td>Application</td>
<td>Rectangle (Objects toolbar)</td>
</tr>
<tr>
<td>Communication unit (NET)</td>
<td>Computer.sd.</td>
</tr>
<tr>
<td>Communication unit line (NET line)</td>
<td>Line (Objects toolbar)</td>
</tr>
<tr>
<td>Station</td>
<td>IED.sd</td>
</tr>
<tr>
<td>LON Clock Master (SLCM)</td>
<td>Satellite dish.-white-.sd with Black radio modem.sd</td>
</tr>
<tr>
<td>Printer</td>
<td>Laser printer.sd</td>
</tr>
</tbody>
</table>

Each symbol can be installed on the system supervision display and connected to the process objects of the supervised system. The state of the supervised system objects (that is normal state, alarm and so on) is represented by color indications.

9.2. Supervision monitoring

Typically system supervision display consists of several symbols indicating the status of MicroSCADA system. The symbols in the Palette of Display Builder should be used to create the application area related system supervision display. It is also possible to create own symbols by using creating subdrawings as described in the SYS 600 *9.1 Process Display Design manual.
Fig. 9.2.-1 An example of a system supervision view

9.2.1. Status indication

The color of the symbol provides information about the status of the object. Table 9.2.1-1 describes some examples of color coding.

<table>
<thead>
<tr>
<th>Color</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>DARK GREY</td>
<td>Not in use.</td>
</tr>
<tr>
<td>GREY</td>
<td>Static (that is, no supervision diagnostic available).</td>
</tr>
<tr>
<td>MAGENTA</td>
<td>Undefined (that is, not sampled, not updated, update blocked or invalid value).</td>
</tr>
<tr>
<td>RED</td>
<td>Alarm, acknowledged.</td>
</tr>
<tr>
<td>GREEN</td>
<td>Normal state, in use.</td>
</tr>
</tbody>
</table>
Event and alarm indications

Each object may contain several events and/or alarms generated to the Event and the Alarm List. Events and alarms of each supervised object are generated according to the event filtering specified during the configuration phase of the Supervision Base functionality.

Fig. 9.2.2.-1 shows both an Event and an Alarm List with the system supervision events and alarms.

Fig. 9.2.2.-1 The Event and Alarm Lists with events and alarms
In case of an alarm, both the group and informative alarms are generated to the Alarm List. The group alarm indicates the current state of the supervised object and it is set to the normal value as the alarm is lowered (that is, the supervised object receives the normalized event). The informative alarm indicates the cause of the alarm (for example Device suspended [13371]) and it is set to the normal value as the alarm is being acknowledged.

In addition to the event and alarm indications, each object may have the event history stored in the log file. The events of each supervised object are stored to the log file according to the event filtering specified during the configuration phase of the Supervision Base functionality.

9.3. Supervision Log Viewer

The Supervision Log Viewer is used to monitor the information that has been collected by the System Self Supervision and the operating system. The Supervision Log Viewer displays transparently the information included in several log file types stored into the hard disk. These files contain information in form of events coming from both hardware and software.

Filters can also be used to focus on information from certain objects of interest. You can view the log entries in the Supervision Log Viewer, but editing is not possible. Updating of the Supervision Log Viewer is based on the user’s actions; it is not updated spontaneously when new log entries are received from the system.

The information collected by System Self Supervision can also appear in Event List and Alarm List, but by default, always in the generated log files.

Table 9.3.-1 presents the user categories that uses the Supervision Log Viewer.

Table 9.3.-1 Users of the Supervision Log Viewer

<table>
<thead>
<tr>
<th>User</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operators</td>
<td>This category of users needs accurate information about the system parts that inhibit or limit the operation.</td>
</tr>
<tr>
<td>Maintenance people</td>
<td>Maintenance people need detailed information about the failing system parts that must be replaced.</td>
</tr>
<tr>
<td>Engineers and after sales support engineers</td>
<td>This category of users need appropriate information about incorrect engineering and behaviour of the system, for example application load, communication load.</td>
</tr>
<tr>
<td>Developers of system products</td>
<td>Developers need detailed information on faults that occurs in SW and HW. This information is regarded as trace information.</td>
</tr>
</tbody>
</table>

9.3.1. Starting Supervision Log Viewer

There are two ways of starting the Supervision Log viewer:

1. Start it from the Tools menu of the SYS 600 Monitor Pro by selecting Supervision Log.
Fig. 9.3.1.-1 Starting the Supervision Log viewer

2. Select Tool Manager from the Engineering menu, then choose System Configuration from the System Configuration folder. In the System Configuration Tool, select the Tools menu and choose System Self Supervision Log. (The required authorization level in the User Management is Engineering).

9.3.2. Toolbar and menus

The following section describes the toolbar buttons and the menus in the Supervision Log Viewer.

Fig. 9.3.2.-1 Unknown process objects

Some of the toolbar buttons and menu items are enabled only when a certain function or view is selected in the Log menu.
The buttons in the toolbar from left to right are:

- Exit the Supervision Log Viewer.
- Log Settings, selects the amount of events to show.
- Setting of Mechanism Parameters for the Unknown Process Object. The button is available when the view Unknown Process Objects is selected.
- Select the Operating System Events and Events Types. This button is available, when the view System Messages from the Operating System is active.
- Scroll one page backward on the list.
- Scroll one page forward on the list.
- Define the color settings for the Supervision Log Viewer and views the system colors.
- Define the font settings for the Supervision Log Viewer and views the font settings of the MicroSCADA Base System.
- View the About Supervision Log Viewer dialog.

The Log menu provides different views of events that can be selected or the Supervision Log Viewer can be exited in the Log menu.

**Common system messages**: This selection shows the events in the scope of Common System Events. More information is given in Section 9.3.3.1. Common Events.

**Unknown process objects**: This selection shows the events in the scope of Unknown Process Objects. More information is given in Section 9.3.3.2. Undefined Process Object Events.

**System events from operating system**: This selection shows the events in the scope of System Events from the operating system. More information is given in Section 9.3.3.3.

**Security events from operating system**: This selection shows the events in the scope of Security Events from the operating system. More information is given in Section 9.3.3.3.

**Application events from operating system**: This selection shows the events in the scope of Application Events from the operating system. More information is given in Section 9.3.3.3.

**Exit**: Exit ends the Supervision Log Viewer session.

The View menu contains several functions, which are described in the following sections. The menu items in the View menu affect the view selected from the Log menu.

**All events**: This option displays all the events of the selected log type, no filtering. This is the default selection, if not otherwise defined into the Supervision Log profile.

**Use event filter**: Filtering is activated according to the definitions in the Supervision Log profile dialog in the Filters menu.

**Newest first**: This option sorts the events in the view presented in time order with the newest event on the top. This is the default selection, if not otherwise defined into the Supervision Log profile.
**Oldest first:** This option sorts the events in the view presented in time order with the oldest event on the top.

**Details:** This option displays all the event information in the Details dialog for the selected event in the view. Applicable only when an operating system log type is active in the Supervision Log viewer, that is system events, security events or application events. You can also see the details by double-clicking on an event line in the view.

**Next page:** This function scrolls forward one page on the list. The count of events to be shown in the view page in Supervision Log Viewer is defined in the Log Settings dialog accessed from the Options menu.

**Previous page:** This function scrolls the list backward one page. The count of events to be shown in the view page in the Supervision Log Viewer is defined in the Log Settings dialog accessed from the Options menu.

**Refresh:** The Supervision Log Viewer is not automatically updated if new events are received into log files simultaneously. When you refresh the view, these new events become visible in the view. Note that if the Oldest First selection is active in the View menu, the newest events will be included at the bottom of the last page.

The **Filter** menu is used to select filters and the Supervision Log profile.

**Unknown process objects:** This function is used to select stations (e.g. relay units), from which the unknown process object events are to be supervised. Unknown Process Objects are events that are not preconfigured in the system. You will find more information in Section 9.3.3.2. Undefined Process Object Events.

The Unknown Process Objects are available only when the view is selected from the Log Menu.

![Unknown Process Objects dialog](UPO_Dialog)

*Fig. 9.3.2.-2 Unknown Process Objects dialog*
Mechanism In Use option enables or disables the collecting of events related to the Unknown Process Objects.

If a large number of events is received into the system, the enabling of this function increases the system load.

The Common System Messages Enabled option enables or disables the Common System Messages.

You can type the addresses of the stations to be supervised to the Station Numbers to Capture box. Value 0 means all the stations, while any other numbers, separated by commas, are interpreted as addresses.

The Append Numbers option defines whether the new station numbers listed above are appended to the list of Station Numbers to Capture or not.

Operating system events: This command is used to display the configuration of how Microsoft Windows operating system events are to be supervised in the system. You will find more information in Section 9.3.3.2. Undefined Process Object Events.

The function Operating System Events can be activated when any of the operating system events views are active, that is, selected from the Log Menu.

The following event types can be selected:

- ERROR
- WARNING
- INFORMATION
- AUDIT SUCCESS
- AUDIT FAILURE

If a large number of events is received into the system, the enabling of this function increases the system load.
• Error events indicate significant problems that should be informed to the user. These types of events usually indicate a loss of functionality or data.

• Warning events indicate problems which are not significant immediately. However, they are indicators for conditions, which may cause problems in the future.

• Information events indicate the typically infrequent, but significantly successful operations in Microsoft Windows. For example, when Microsoft SQL Server has been initialized successfully, there may be a need to log an information event stating that SQL Server has started successfully.

• Success audit events are security events which occur, when an audited access attempt has been successful. For example, a successful logon has occurred in Microsoft Windows.

• Failure audit events are security events which occur, when an audited access attempt has not been successful. For example, an unsuccessful logon has occurred in Microsoft Windows.

You can provide the settings in Fig. 9.3.2.3 on-line via the HSI and they are in use until the MicroSCADA system is shut down. The settings in the MicroSCADA Base System configuration file, (SYS_BASCON.COM), are read at start-up. Therefore, permanent changes have to be made in the MicroSCADA Base System (SYS_BASCON.COM), for example, settings like enabled or disabled, and picking of the types of events to be supervised. Therefore, if the basic configuration is that the whole function is set disabled or some of the selectable events are not supervised, these events are unavailable in the dialog.

**Supervision Log Profile:** This command filters the displayed event information in the Supervision Log Viewer. Only the events which fulfill the filter conditions and are found in the log files are shown in the Supervision Log Viewer. In this way, it is easier to focus on events received from a certain supervised object item.

The Supervision log profile is available for log types selected from the Log menu. You can select the following profile for all the log types:

• Events from the first event to the last event

• Events within a certain time period

• Events after the last system start-up

You can also select the interesting station items to be monitored among the Unknown Process Object log types or interesting communication unit, communication unit line and station items to be monitored among the Common System Message log types.
Fig. 9.3.2.-4  Supervision Log Profile dialog

You can load the Supervision Log profile from a specified folder by clicking **Load New**. The Supervision Log profile files include extension .evt. To save the defined Supervision Log profile at that moment in the Supervision Log Viewer to the specified folder, click **Save As**. It is preferred to use the default file extension .evt, when renaming the profile file. **OK** activates the profile settings to be used in the Supervision Log Viewer and by clicking **Cancel** no changes are made to the profile settings.

The profile settings are used immediately and also at the next start up of the Supervision Log Viewer, that is, until they are changed for the next time or another profile is loaded. The profiles are also user-specific.

The **Options** menu provides settings for changing the environment in the Supervision Log Viewer. The changes done in the Supervision Log Viewer by using the **Options** menu commands have an immediate effect on the functionality of the Supervision Log Viewer and are also stored into a user-specific parameter file. When the Supervision Log Viewer is opened the next time, these definitions are taken into use again.

**Toolbar visible:** By selecting this option, you can choose to have the toolbar buttons visible or invisible.
Background color: If you select this menu item, the Color Chooser will be displayed. Then you can select the color that you want to use as the background color in the Supervision Log Viewer. You can also see the System colors, but not change them.

Foreground color: If you select this menu item, the Color Chooser will be displayed. Then you can select the color that you want to use as the foreground color in the Supervision Log Viewer. You can also see the System colors, but not change them.

Default colors: Restores the default colors to be used both for the background and foreground in the Supervision Log Viewer.

Configure font: If you select this menu item, the Font Chooser will be displayed. Then you can select the font and size of the text.

![Font Chooser](image)

**Fig. 9.3.2.-5 Setting fonts for the Supervision Log viewer**

Default font: Restores the default font settings in the Supervision Log viewer.

Enlarge font: Enlarges the font size used in the Supervision Log viewer.

Reduce font: Reduces the font size used in the Supervision Log viewer.

Log settings: The Log Settings function is used to access the Log Settings dialog. In this dialog it is possible to define how many events should be shown in each page of the Supervision Log Viewer. For performance reasons
it is better to use a lower amount, because increasing the event count increases also the opening time of the Supervision Log viewer. The default value is 100. The value range for the event count is between 100 and 1000.

The Help menu offers additional information about the Supervision Log Viewer.

9.3.3. Types of log events

Each type of the log information can be viewed only from the appropriate menu item in the Log Menu. Simultaneously, one log event type can be viewed at a time in the Supervision Log Viewer.

Views containing information about the MicroSCADA system:

- Common System Messages
- Unknown Process Messages

Views containing information about the Microsoft Windows operating system:

- System Events
- Security Events
- Application Events

9.3.3.1. Common events

Common events contains events from the communication unit, as well as predefined events in stations and in the MicroSCADA Base System. Predefined events occur, for example, when a connection to a station is lost or re-established. A MicroSCADA Base System event occurs related to certain events from a printer, a communication unit or an external clock connected to the system.

The Supervision Base stores the incoming events and the information related to them into a common system message file, which is located in the subfolder of the current application. In this file each line allocates one event.

The Supervision Log Viewer adapts the functionality according to the definitions done during the configuration of the Supervision Base functionality. For the common system message file these are: location, length and used delimiter for event information in this common system message file.
Common Events contain the following information:

- Time stamp with milliseconds, for example, 1999-12-10 11:39:58.832
- Object type, for example, Station
- Object number, for example, 115
- Communication unit (NET) number (if any), for example, 2
- Communication unit line (NET Line) number (if any), for example, 1
- Status code, for example, Device suspended [13371] (system message from the communication unit) or text, for example, Running (if application or Base System event)

### 9.3.3.2. Undefined Process Object events

Undefined Process Objects are events, which have not been predefined in the MicroSCADA system. Typical events are e.g. spontaneous messages from the relay modules. Supervision Base stores the incoming undefined process object events to the undefined process objects file if it has been activated by the user (see Fig. 9.3.2.-2, option Mechanism In Use). The file is located in the subfolder of the current application. In this file each line contains one event.

The Supervision Log Viewer adapts the functionality according to the definitions done during the configuration of the Supervision Base functionality. For the undefined process object file these are: location, length and used delimiter for event information in this undefined process object file.
Undefined Process Objects events contain the following information:

- Time stamp with seconds, for example, 1999-12-14 08:08:34
- Unit number attribute name, for example, Message to station
- Unit number, that is, station number, for example, 113
- Object address attribute name, for example, object address
- Object address value, for example, 3710

### Operating System events

The Operating System based events are generated by Microsoft Windows. The information in the log file is consistent with events visible through Windows Event Viewer. Three different event types are generated by Microsoft Windows: System, Security and Application. The Supervision Log Viewer stores these incoming events into files of their own, if defined so. These different event types will be described in the following sections.

### System events

Microsoft Windows System Events are saved in the file system events log file, which is located in the subfolder of current application. In this file multiple lines are allocated for information of one event. The Supervision Log Viewer recognizes the beginning of each event from the event tag header.
System Events contain the following information:

- Time stamp with seconds, for example, 1999-12-03 08:30:52.
- Source specific event id, which identifies the message together with the name of the source, for example, 9.
- Type of the event (ERROR, WARNING, INFORMATION, AUDIT_SUCCESS, AUDIT_FAILURE), for example, INFORMATION.
- Source specific subcategory. This information is shown only in the Event Details dialog.
- Active user (if possible to define) at the time when the event was logged, for example, Administrator.
- Name of the computer that generated the event, for example, FIMIT-RVS-S11.
- Domain name of the computer that generated the event.
- Name of the source, that is, application, service, driver, subsystem that generated the entry, for example, Print.
- Log type of the event is always SYSTEM. When SYSTEM events are shown in the Supervision Log Viewer, it is not possible to view SECURITY or APPLICATION events simultaneously.
• Source specific message string. Each line of the message is in different elements of the vector. If the line is longer than 255 characters, it will be cut to 255 characters. This information is shown only in the Event Details dialog.

If the text N/A, that is, Not Applicable, is shown for an event it means that the specified item is not included in the received event information.

Security events

Microsoft Windows Security Events are saved in the security events log file, which is located in the subfolder of the current application. In this file multiple lines are allocated for information on one event. The Supervision Log Viewer recognizes the beginning of each event from the event tag header.

Security Events contain the following information:
• Time stamp with seconds, for example, 1999-12-03 08:30:52.
• Source specific event id, which identifies the message together with the name of the source, for example, 9.
• Type of the event (ERROR, WARNING, INFORMATION, AUDIT_SUCCESS, AUDIT_FAILURE), for example, ERROR.
• Source specific subcategory. This information is shown only in the Event Details dialog.
• Active user (if possible to define) at the time when the event was logged, for example, Administrator.
• Name of the computer that generated the event, for example, FIMIT-RVS-S11.
• Domain name of the computer that generated the event.
• Name of the source, i.e. application, service, driver, subsystem that generated the entry, for example, Print.
• Log type of the event is always SECURITY. When SECURITY events are shown in the Supervision Log Viewer, it is not possible to view SYSTEM or APPLICATION events simultaneously.
• Source specific message string. Each line of the message is in different elements of the vector. If the line is longer than 255 characters, it will be cut to 255 characters. This information is shown only in the Event Details dialog.

If the text N/A, that is, Not Applicable, is shown for an event it means that the specified item is not included in the received event information.

Application events

Microsoft Windows Application Events are saved in the application events log file, which is located in the subfolder of the current application. In this file multiple lines are allocated for information on one event. The Supervision Log Viewer recognizes the beginning of each event from the event tag header.

Application Events contain the following information:
• Time stamp with seconds, for example, 1999-12-03 08:30:52.
• Source specific event id, which identifies the message together with the name of the source, for example, 9.
Operation Manual

- Type of the event (ERROR, WARNING, INFORMATION, AUDIT_SUCCESS, AUDIT_FAILURE), for example, WARNING.
- Source specific subcategory. This information is shown only in the Event Details dialog.
- Active user (if possible to define) at the time, when event was logged, for example, Administrator.
- Name of the computer that generated the event, for example, FIMIT-RVS-S11.
- Domain name of the computer that generated the event.
- Name of the source, that is, application, service, driver, subsystem that generated the entry, for example, Print.
- Log type of the event is always APPLICATION. When APPLICATION events are shown in the Supervision Log Viewer, it is not possible to view SYSTEM or SECURITY events simultaneously.
- Source specific message string. Each line of the message is in different elements of the vector. If the line is longer than 255 characters, it will be cut to 255 characters. This information is shown only in the Event Details dialog.

If the text N/A, that is, Not Applicable, is shown for an event it means that the specified item is not included in the received event information.
A

Acknowledge
  All .......................................................................................................98
  Current page .......................................................................................98
Acknowledgement Dialog .................................................................106
Acknowledgement indication .............................................................106
Activation ...............................................................................................80
Active acknowledged alarms ....................................................99, 100, 106
AI type process object ..............................................................................97
Alarm blocking .................................................................................. 103
Alarm buffer ........................................... ....................97, 99, 103, 105, 107
Alarm classes .................................................................................. 103, 109
Alarm history ..........................................................................................107
Alarm limit ...............................................................................................36
Alarm List .........................................................................................13, 107
Alarm row .................................................................................................24
Alarm state ...............................................................................................105
Alarm text line .......................................................................... 95, 100, 106
Alarm types ............................................................................................106
Allowed procedures ..................................................................................50
Analog measured value ............................................................................97
Application ...............................................................................................30
Application Events .................................................................................154
Application language ................................................................................31
Application Settings .................................................................................30
Assign type ...............................................................................................48
Attribute list ..............................................................................................44
Authorization group ..................................................................................91
Authorization level ..................................................................................30, 32, 38, 108
Available attributes ..................................................................................47

B

Base system ............................................................................................114
BGU_TIMEBA:C .....................................................................................33
BGU_TIMEFO:C .....................................................................................33
BI type process object ..............................................................................97
Blocking conditions ..................................................................................119, 122
blocking functionality .............................................................................122
Blocking List .................................................................................. 115, 127
Blocking list toolbar ...............................................................................115
Blocking on bay level .............................................................................122
busbar coloring .........................................................................................76

C

Calendar ....................................................................................................44
Changing event texts ................................................................................86
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing password</td>
<td>43</td>
</tr>
<tr>
<td>Color coding</td>
<td>140</td>
</tr>
<tr>
<td>Command procedures</td>
<td>44</td>
</tr>
<tr>
<td>Comments</td>
<td>90</td>
</tr>
<tr>
<td>Communication failure</td>
<td>97</td>
</tr>
<tr>
<td>Configuration</td>
<td>86</td>
</tr>
<tr>
<td>Current alarm situation</td>
<td>102</td>
</tr>
<tr>
<td>Day color</td>
<td>46, 48</td>
</tr>
<tr>
<td>Day name</td>
<td>48</td>
</tr>
<tr>
<td>Day type</td>
<td>48, 50</td>
</tr>
<tr>
<td>Day type setting</td>
<td>46</td>
</tr>
<tr>
<td>Daylight Saving Time</td>
<td>33</td>
</tr>
<tr>
<td>DB type process object</td>
<td>97</td>
</tr>
<tr>
<td>Default day settings</td>
<td>44</td>
</tr>
<tr>
<td>Default event text</td>
<td>84</td>
</tr>
<tr>
<td>Default settings files</td>
<td>105</td>
</tr>
<tr>
<td>Dialog</td>
<td></td>
</tr>
<tr>
<td>Busbar Coloring Settings dialog</td>
<td>77</td>
</tr>
<tr>
<td>DMS</td>
<td>8</td>
</tr>
<tr>
<td>Double indication</td>
<td>97</td>
</tr>
<tr>
<td>Event activation</td>
<td>80</td>
</tr>
<tr>
<td>Event handling</td>
<td>88</td>
</tr>
<tr>
<td>Event presentation</td>
<td>88</td>
</tr>
<tr>
<td>Event text line</td>
<td>79</td>
</tr>
<tr>
<td>Filtering criteria</td>
<td>107</td>
</tr>
<tr>
<td>Filters</td>
<td>86, 92, 98, 108</td>
</tr>
<tr>
<td>Fleeting alarms</td>
<td>99</td>
</tr>
<tr>
<td>Frozen mode</td>
<td>98, 105, 106</td>
</tr>
<tr>
<td>Graphic view mode</td>
<td>128</td>
</tr>
<tr>
<td>Help</td>
<td>99</td>
</tr>
<tr>
<td>History archive</td>
<td>88</td>
</tr>
<tr>
<td>History database</td>
<td>86</td>
</tr>
<tr>
<td>History Database (HDB)</td>
<td>86, 88, 90, 91</td>
</tr>
<tr>
<td>Human System Interface (HSI)</td>
<td>115, 127</td>
</tr>
<tr>
<td>Inactive acknowledged alarms</td>
<td>106, 107</td>
</tr>
<tr>
<td>Inactive unacknowledged alarms</td>
<td>99, 106</td>
</tr>
</tbody>
</table>
# MicroSCADA Pro Operation Manual

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incoming binary signal</td>
<td>97</td>
</tr>
<tr>
<td>Incoming process data</td>
<td>102</td>
</tr>
<tr>
<td>In-day period</td>
<td>49</td>
</tr>
<tr>
<td>Indication signals</td>
<td>114</td>
</tr>
<tr>
<td>Internal alarms</td>
<td>97</td>
</tr>
<tr>
<td>Internal events</td>
<td>88</td>
</tr>
<tr>
<td>Internal objects</td>
<td>122</td>
</tr>
<tr>
<td>Language settings</td>
<td>31</td>
</tr>
<tr>
<td>Latest Alarm</td>
<td>98</td>
</tr>
<tr>
<td>Layout</td>
<td>82</td>
</tr>
<tr>
<td>Local language</td>
<td>31</td>
</tr>
<tr>
<td>Lockout duration</td>
<td>32</td>
</tr>
<tr>
<td>Log events</td>
<td>142</td>
</tr>
<tr>
<td>Log file</td>
<td>142</td>
</tr>
<tr>
<td>Lower time limit</td>
<td>110</td>
</tr>
<tr>
<td>MFC</td>
<td>8</td>
</tr>
<tr>
<td>Monitor language</td>
<td>30, 31</td>
</tr>
<tr>
<td>Multiple selection</td>
<td>46</td>
</tr>
<tr>
<td>Navigation objects</td>
<td>82</td>
</tr>
<tr>
<td>Network Control Center (NCC)</td>
<td>30</td>
</tr>
<tr>
<td>New value</td>
<td>32</td>
</tr>
<tr>
<td>Outgoing process data</td>
<td>102</td>
</tr>
<tr>
<td>Persisting alarms</td>
<td>99, 100</td>
</tr>
<tr>
<td>Presentation Mode</td>
<td>98</td>
</tr>
<tr>
<td>Printout</td>
<td>80, 86</td>
</tr>
<tr>
<td>Process alarms</td>
<td>97</td>
</tr>
<tr>
<td>Process control settings</td>
<td>34</td>
</tr>
<tr>
<td>Process database</td>
<td>90, 102, 114</td>
</tr>
<tr>
<td>Process Display</td>
<td>25</td>
</tr>
<tr>
<td>Process events</td>
<td>88</td>
</tr>
<tr>
<td>Process list types</td>
<td>25</td>
</tr>
<tr>
<td>Process object</td>
<td>97, 105, 107, 122</td>
</tr>
<tr>
<td>Process object attributes</td>
<td>119</td>
</tr>
<tr>
<td>Process object values</td>
<td>114</td>
</tr>
<tr>
<td>Registration</td>
<td>80</td>
</tr>
<tr>
<td>Report Settings</td>
<td>37</td>
</tr>
</tbody>
</table>
Run command procedure ................................................................. 48

S
Security Events .................................................................................. 154
Sequential printouts ........................................................................... 86
Session duration ............................................................................... 32
Session expiring notify times .......................................................... 32
Setting Calendar options ................................................................. 49
Settings ............................................................................................. 98
Settings tool ...................................................................................... 105
Show object identification ................................................................. 35
Signal .............................................................................................. 113, 114
SSS ..................................................................................................... 137
SSS Backbone .................................................................................. 137
SSS HSI .......................................................................................... 137, 138
Standard filters ............................................................................... 92
Starting
Trends .............................................................................................. 126
starting
Alarm list ........................................................................................ 97
Blocking list ................................................................................... 114
Event list ......................................................................................... 81
Station (process) picture ................................................................. 14
Status bar ......................................................................................... 24
Substation Control System (SCS) ..................................................... 30
Supervision Base ........................................................................... 137, 150
Supervision Log Profile ................................................................. 147
Supervision Log Viewer ................................................................ 142, 150, 152
Supervision Monitoring .................................................................. 137, 138
SYS 600
Display Builder ............................................................................... 76
Monitor Pro ..................................................................................... 76
System error .................................................................................... 97
System events ............................................................................... 152
System location ............................................................................. 30
System Manager .......................................................................... 28, 30
System Self Supervision ................................................................. 97

T
Colorings modes tab ....................................................................... 77
Colors tab ....................................................................................... 78
General tab .................................................................................... 77
Template 1 .................................................................................... 96, 99, 100
Template 2 ................................................................................... 99, 106
The Day type list ........................................................................... 51
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time period start/stop</td>
<td>48</td>
</tr>
<tr>
<td>Trend Report</td>
<td>13</td>
</tr>
<tr>
<td>Unacknowledged alarms</td>
<td>99, 103</td>
</tr>
<tr>
<td>Undefined Process Objects</td>
<td>151</td>
</tr>
<tr>
<td>Unknown Process Objects</td>
<td>145</td>
</tr>
<tr>
<td>Updating mode</td>
<td>105, 106</td>
</tr>
<tr>
<td>Upper time limit</td>
<td>110</td>
</tr>
<tr>
<td>Up-to-date alarm information</td>
<td>107</td>
</tr>
<tr>
<td>User interface</td>
<td>39</td>
</tr>
<tr>
<td>User language</td>
<td>31</td>
</tr>
<tr>
<td>User levels</td>
<td>38</td>
</tr>
<tr>
<td>User Management</td>
<td>28, 38</td>
</tr>
<tr>
<td>User profile</td>
<td>31</td>
</tr>
<tr>
<td>VS-monitor</td>
<td>27</td>
</tr>
<tr>
<td>Watch Dog</td>
<td>103</td>
</tr>
</tbody>
</table>